
The illustration on the next page provides an overview of your Macintosh
PowerBook computer. To set up your computer for the first time, you need
the power adapter and the power cord that came with it.

When setting up your computer, place your computer on a sturdy, flat surface
near a grounded electrical outlet. Before following the setup instructions in
this chapter, you may want to read “Arranging Your Work Area and
Equipment” i n Appendix A for tips on adjusting your work furniture and
computer so that you’re comfortable when using the computer.

When you’ve determined where to put the computer and reviewed the
information about arranging your work area and the illustration of the
PowerBook, turn to “Opening the Display” to begin the setup procedure.

1

1 Getting Started

Follow the instructions in this

chapter to set up your computer.

Notes
To continue reading, use the scrollbar on the right. To go to a new section, click its title on the left.
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Opening the display

1 Slide the latch to the left and lift up the display.

2 Position the display at a comfortable viewing angle. 

You can adjust the angle of the display at any time by tilt ing it toward or away
from you.

Slide the latch to the left to open the display. 
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3 Adjust the elevation feet to raise the computer.

The back of the keyboard is slightly elevated when the feet are in use.

It is a good idea to lower the elevation feet whenever you are using your
computer on a flat surface. 

Removing the battery’s paper wrapper

Most new PowerBooks are shipped with a paper wrapper covering the battery
to protect it from losing its charge completely. If there is a wrapper, you need
to remove it before the battery will provide power for the computer.

1 With the display open, peel off the part of the label on the computer’s case, taking care
not to tear the wrapper.

2 Close the display (with the detached part of the wrapper outside of the computer).

To lower the foot, press the release
button. The foot extends automatically. 

To raise the foot, press the release button while
pushing up on the foot until it clicks into place. 
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3 Press the battery release button on the battery.

4 Slide the battery out of its compartment.

5 Carefully remove the wrapper from the battery.

Avoid touching the battery’s metal contacts as you peel off the wrapper.

6 Replace the battery and open the display.

After removing the wrapper, you can save it for reuse or throw it away.

Plugging in the co mputer

Plugging in the power adapter recharges the computer’s battery. You should
plug in the power adapter in case the battery has drained during shipping or
storage. (If the battery was completely drained, the power will come on
automatically when the power adapter is attached.)

WARNING Use only the power adapter that came with your Macintosh
PowerBook computer, part number M4895 (or an adapter from another
manufacturer that is designed specif ically for your PowerBook model).
Adapters for other electronic devices (including other Macintosh
PowerBook models and other portable computers) may look similar, but
they may damage your computer.

1 Press the button on the battery. 2 Slide the battery out.
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1 Plug one end of the power cord into the power adapter and the other end into a three-
hole grounded outlet or power strip.

2 Plug the power adapter plug into the power adapter port (marked with the icon ¯) on the
back panel of the computer.

Power cord

Power adapter

Power adapter plug

¯ Power adapter port 1

2

WARNING  This equipment is intended to be electrically grounded. The
power adapter that came with your Macintosh PowerBook is equipped
with a three-wire grounding plug—a plug that has a third (grounding)
pin. This plug will f it only a grounded AC outlet. This is a safety
feature. If you are unable to insert the plug into the outlet, contact a
licensed electrician to replace the outlet with a properly grounded
outlet. Do not defeat the purpose of the grounding plug!
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Turning the co mputer on

To turn on the computer for the first time and prepare it to record any settings
you establish, follow these steps.

1 Press the Power key at the upper-right corner of the keyboard to turn the computer on.

You should hear a tone when you turn on the computer. It takes the computer
a few moments to start up. 

As the computer starts up, several messages appear on the screen.

2 To be certain that the computer saves any new settings you establish as you work with
it, press and hold the Power key for 2 seconds.

A message appears, asking whether you want to shut down the computer.

3 In the message on the screen, click Restart.

To click Restart, move your finger on the trackpad to move the arrow on 
the screen until the tip of the pointer is on Restart and press the trackpad
button once.

The computer turns off briefly, then starts up again. 

Note:  You only need to use this restart procedure the first time you turn on
the computer or after the battery has been completely discharged or has been
out of the computer for three days or more. 

P

Power key
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After the computer has started up for the second time, go to the section
“What’s Next?” for more instructions, or finish reading this chapter to learn
how to turn the computer off and put it to sleep.

If the computer does not start up, go to the next section, "Problems Turning
the Computer On?"

Problems turning the co mputer on?
m Nothing happened when you pressed the Power key.

The battery may be drained. Make sure you plugged in the power adapter,
and that the power adapter is fi rmly connected to both the computer and a
power source. If the power adapter is plugged into a power strip, make sure
the power strip is plugged in and turned on. If the computer doesn’t make a
sound when you press the Power key, press the reset button (marked with
an I) on the back of the computer. Once the battery has charged you
should be able to use the Power key normally.

If the computer still doesn’t turn on, see “Problems Starting Up the
Computer” in Chapter 5.

m The computer made a sound, but you can’t see anything on the screen.

Adjust the brightness control (marked with the icon ¤) until an image
appears and the screen is easy to read. 

¤  Brightness control
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m You see a picture of a disk with a blinking question mark on the screen.

This icon usually means that the computer can’t find system software on
the hard disk or any disks attached to the computer. You may need to
reinstall system software. See “Reinstalling System Software” i n Chapter 6.

Turning the co mputer off

Always use one of the following methods to shut down the computer. If you
don’t, you risk losing any work you haven’t previously saved on a disk. You
also risk losing any open documents.

Turning the co mputer off w ith the Power key

To turn the computer off, press the Power key. Detailed instructions follow. 

1 If the computer is in sleep, press the Power key (or any key on the keyboard except 
Caps Lock) to wake it.

For information on the sleep feature of your Macintosh PowerBook, see
“Putting the Computer to Sleep,” next.

2 Press and hold the Power key for about two seconds.

The following dialog box appears on the screen:

3 Press the Return key on the keyboard (or click the Shut Down button in the dialog box).
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Turning the co mputer off w ith the Shut Down co mmand

You can also turn your computer off by using the Shut Down command in the
Special menu. Follow these steps:

1 If the computer is in sleep, press the Power key (or any key on the keyboard except Caps
Lock) to wake it.

2 Move the tip of the arrow to the word “Special” at the top center of the screen.

If the word “Special” does not appear at the top of the screen, you’re not
working in the Finder. Choose Finder from the Application menu at the 
far-right end of the menu bar.

3 With the tip of the arrow on the word “Special,” press and hold down the trackpad button.

4 While holding down the trackpad button, move the arrow until the words “Shut Down”
are highlighted, then release the button.

Trouble?  If a problem with the computer prevents you from using the Power
key or choosing Shut Down—for example, if the computer “freezes” so that
the pointer does not respond to the trackpad—you can restart the computer
by pressing the Command (x), Control, and Power keys simultaneously. If the
computer doesn’t restart, press the reset button (marked with an I) on the
back of the computer. Use this method only if you cannot choose Shut Down
or Restart when you press the Power key, or if you cannot choose either
command from the Special menu.

Putting the co mputer to sleep

Sleep is a power conservation feature of Macintosh PowerBook computers
that lets you instantly restart the computer and bypass the startup process.
You can extend the period of time your battery will power the computer by
putting the PowerBook to sleep when you won’t be using it for several
minutes or hours. The length of time the computer can be left in sleep
depends on the charge state of the battery.

When the computer is in sleep, it has a darkened screen and appears to be off.
A small green light flashes on the top of the display case when the computer
is in sleep. (Note:  The computer must be on in order for you to put it to sleep.)



To put the computer to sleep, do this:

1 Press and hold the Power key for about two seconds.

2 Click the Sleep button.

Other ways of putting your co mputer to sleep
m You can choose the Sleep command from the Special menu to put your

computer to sleep.

m You can also put your computer to sleep by closing and latching the display.

When the computer is in sleep, a small green light flashes in the upper-
right corner of the display.

For information on other ways of putting the computer to sleep, see Mac OS
Help, available in the Help menu. (See “What’s Next?” later in the chapter for
more information about using Mac OS Help.)

Sleep indicator 

WARNING  Once you put your computer to sleep, listen for the hard disk
to stop spinning before you move your Macintosh PowerBook. Moving
your Macintosh PowerBook with the hard disk spinning can damage
your computer.
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Automatic sleep

If you don’t use the computer for several minutes, it goes to sleep
automatically. This conserves battery power. 

To wake the computer, press any key on the keyboard (except Caps Lock).
The screen will reappear as it was before the computer went to sleep. 

You can control the automatic sleep feature. For more information on sleep
and automatic sleep, see Mac OS Help.

Restarting a co mputer that’s already on

You need to restart your computer—turn it off and back on again—when you
want to make certain changes to settings, use a newly installed system
software file, or start up the computer using a different disk. 

You may also need to restart if you see a “system error” message on the
screen (indicating a temporary software problem). In this case, use the
trackpad to click the Restart button that appears.

Follow these instructions to restart your computer:

1 Press and hold the Power key for about two seconds.

2 Click the Restart button.

You can also do this to restart:

m Choose Restart from the Special menu.

If the Special menu does not appear in the menu bar, you’re not working in
the Finder. Click anywhere on the desktop to return to the Finder.

When you choose Restart, the computer prompts you to save your work,
closes all open programs, and restarts itself. 

Restarting using either of the methods outli ned above does not affect your
RAM disk (if you created one) or its contents.
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Trouble?  If a problem with the computer prevents you from using the Power
key or choosing Restart—for example, if the computer “freezes” so that the
pointer does not respond to the trackpad—you can restart the computer by
pressing the Command (x), Control, and Power keys simultaneously. 

If the computer doesn’t restart, press the reset button (marked with an I) on
the back of the computer. (If the computer is on but “frozen,” pressing the
reset button will turn off the computer. You will then need to press the Power
key to turn it on.) Use this method only if you cannot choose Shut Down or
Restart from the dialog box that appears when you press the Power key, or if
you cannot choose either command from the Special menu.

What’s next?

You’ve now finished setting up your Macintosh PowerBook. Continue with
one of the following steps:

m If you are new to the Macintosh, use the online information provided on
your PowerBook to learn more about using your computer. 

To begin, use the Mac OS Setup Assistant that automatically opens on your
screen to enter some basic information, such as your name and
organization, the date, time, and time zone, and your preference for a
simplif ied interface or the standard Mac OS interface. To advance through
the Setup Assistant, click the forward or back arrow in the lower-right part
of the window. (Move your finger on the trackpad to move the arrow on
the screen until the tip of the pointer is on the forward or back arrow and
press the trackpad button once.) You can leave Mac OS Setup Assistant any
time by clicking the close box (at the upper-left corner of the window) and
clicking Quit in the message that appears.

After you’ve used the Mac OS Setup Assistant, locate the Help menu at the
top of the screen. (Move your finger on the trackpad to move the arrow on
the screen until the tip of the pointer is on “Help.” Press and hold down the
trackpad button and move the arrow downward until the word “Help” i s
highlighted, then release the trackpad button). When the Mac OS Help
window opens, move the arrow to “Learning the Basics” at the top of the
list of topics. Then move the arrow to “OK” at the bottom right of the
window and press the trackpad button once. 
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m If you are an experienced Macintosh user, complete the information in the
Mac OS Setup Assistant and explore the Mac OS Info Center on your
computer’s hard disk to learn about your PowerBook’s features and the
software provided with your system. Also look at the online instructions in
the Help menu.

m If you have additional equipment for your computer, see Chapter 2, “Using
Expansion Bay Modules and PCCards,” and Chapter 3, “Connecting
Additional Equipment,” for instructions. (If you are a new Macintosh user,
you should complete “Learning the Basics” i n Mac OS Help before
connecting additional equipment.)
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Read this chapter for 

information on using expansion 

bay modules and PC Cards.

Using expansion bay modules

The floppy disk drive and the CD-ROM drive for your Macintosh PowerBook
are removable modules, which you can easily switch or replace with another
module. The place in your computer where modules go is called theexpansion
bay. (The floppy disk drive is installed in the expansion bay at the factory.)

You can switch the modules, such as the floppy disk drive, CD-ROM drive or
PCCard storage case, or remove a module while the PowerBook is turned on,
in sleep, or shut down. All expansion bay modules are inserted and removed
in the same way. 

To protect your work and to be sure that the computer recognizes which
module is in use, fi rst quit any programs that may be using files on the disk in
that module. Then select the disk’s icon and choose Put Away from the File
menu or drag the icon to the Trash.

IMPORTANT  Don’t switch modules while the computer is starting up. Also take
care not to remove a module if a floppy disk or CD-ROM disc is inserted and 
in use.

If you purchase an expansion bay module from an independent supplier, be
sure to follow the instructions that came with the device. Some modules may
have special requirements, such as shutting down the computer before
inserting or removing the module. At least one manufacturer makes an
internal power adapter for use in the expansion bay.

2 Using Expansion Bay Modules and PC Cards



Removing an expansion bay module

To remove an expansion bay module from your Macintosh PowerBook, follow
these steps:

1 Quit any application programs or files that are using the floppy disk or compact disc
(CD) or other medium inserted in the expansion bay module.

Remember to save your work.

2 If a floppy disk or CD is inserted in the module, click its icon to select it and drag its icon
to the Trash (or choose Put Away from the File menu).

You should not remove the module if a disk is in use. If you have any other
kind of optional expansion bay module, make sure you drag the icon for its
media to the Trash or select the icon and choose Put Away from the File menu.

3 Unlock the expansion bay module by sliding the module release latch on the bottom of
your Macintosh PowerBook in the direction of the arrow.

To unlock the module, slide the latch
on the underside of the computer.
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4 Hold the module by the gripping surface and pull it out of the computer.

IMPORTANT  You should not remove an expansion bay module if it is in use or
you may lose data. If you try to remove the module when it is in use, you’ll
see a message telli ng you to reinsert it. Reinsert the module, quit any files or
programs that may be using the floppy disk (or other medium inserted in the
module), then select the disk’s icon and choose Put Away from the File menu
or drag the disk’s icon to the Trash. (If the module contains the startup disk,
you can’t remove the module or drag the disk to the Trash.)

To be sure that you don’t get another in-use message, wait 5 seconds after
quitting programs and ejecting a disk before you remove the module.

If you put your computer to sleep while a floppy disk or other medium is
inserted, the green in-use light to the left of the module will fl ash (similar to
the sleep indicator light on your computer’s display). You should not remove
the module while the in-use light is on or flashing.

Hold the module by the gripping surface
and pull it completely out of the computer.

The module release latch automatically slides back
into its proper position as you remove the module.

Gripping surface
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Inserting an expansion bay module

To reinsert the expansion bay module, slide the module in. Make sure the
gripping surface is facing down. The release button automatically returns to
the locked position.

Be sure the module is completely inserted. If it does not insert properly, reset
the module release latch to the unlocked position (as in step 3 earlier) before
reinserting the module.

The expansion bay can use a wide component, such as the 5.25-inch CD-ROM
drive, or a narrower component, such as the 3.5-inch floppy disk drive. When
a narrower device is in the expansion bay, a small flap covers the emptypart of
the bay. When a wider drive is inserted, the flap folds into the bay.

Note:  A plastic storage case for PCCards is provided with your PowerBook.
This case fits into the expansion bay. If you want to make the computer as
light as possible, you can remove the module in the expansion bay and insert
the PCCard storage case. Always keep a module or the PCCard storage case
in the expansion bay to protect the connectors inside the bay.

Flap for narrow module
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Using a CD in the CD-ROM drive

You insert or remove the CD-ROM drive in the same way as any other module. 

Inserting a disc

To load a compact disc in the drive, follow these steps:

1 Start up the PowerBook, if it’s not already on.

2 Press the Open button on the outside of the CD-ROM module to open its tray.

The tray opens part way.

(If the tray doesn’t open, a disc may already be in the drive. Drag its icon to the
Trash to open the tray. You’ll see a message if the disc is in use; in that case,
quit the program in use or close the disc’s window if no program is in use.)

3 Pull the tray all the way open and place a CD-ROM disc in the tray, with the label facing up.

Make sure the disc is lying flat in the tray and is seated firmly on the spindle.

Avoid touching the drive’s lens.

Insert the disc,
label side up.
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4 Push the tray in to close it.

When the CD-ROM drive is in use, you may notice some vibration and noise
as the compact disc spins rapidly. Certain discs can cause the drive to vibrate
because they have heavily inked artwork or a label that creates an imbalance. 

Variations in speed of CDs is normal. Different types of disks run at different
speeds; for example, audio CDs all run at a low speed.

The high-speed CD-ROM drive for your PowerBook contains an intelli gent
sensor that detects an unbalanced disc and adjusts the disc speed to minimize
vibration. Even when the speed changes, the CD still functions normally, but
it may transfer information at a somewhat slower rate.

Some vibration is not unusual for a high-speed CD-ROM drive, in part
because there is no specif ication for balance of compact discs. To minimize
vibration from unbalanced compact discs, do not put labels on your CDs.
Place the computer on a flat, solid surface when using the CD-ROM drive. 

Keep the CD-ROM drive’s tray closed except when loading discs. This
prevents dust from getting inside the mechanism. Also be sure to keep the
CD’s recorded surface (the side opposite the label) free of contamination such
as fingerprints, dust, and grease. The performance of the drive depends on
the optical quality of the CD media.
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Ejecting a disc

Follow these instructions to open the tray and eject a CD-ROM disc from 
the drive:

1 Open the tray.

There are several ways to open the tray of your CD-ROM drive.

If a CD-ROM disc icon appears on your screen, do one of the following:

m Select the disc icon on your screen and drag the icon to the Trash.

m Click the disc icon and choose the Put Away command in the File menu.

m While the CD player’s window is active, choose Eject CD from the File
menu, or simultaneously press the x and E keys. (Do not remove the
module if you use this method of ejecting the disc.)

m Use the pop-up menu in the CD section of the Control Strip to eject a CD.

If no CD-ROM disc icon appears on your screen, do this:

m Press the Open button on your CD-ROM drive.

2 Take the disc out of the tray.

Store your disc in a safe place, away from heat, dust, and moisture.

3 Push the tray in to close it.

To avoid possible damage to the tray or the drive, keep the tray closed when
you are not using it.
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If you still can’t eject a disc, try this method:

If the standard methods of ejecting a CD do not work (or the computer is
shut down), you can eject the disc manually. Carefully insert the end of a
straightened paper clip into the small hole near the CD-ROM drive’s opening,
and push firmly until the tray disengages. Pull the tray open, remove the disc,
and close the tray.

Insert the end of a
large, straightened
paper clip into
this hole.
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Locking an expansion bay module 

You can purchase a security cable and lock to protect your Macintosh
PowerBook. With a lock, you can do the following:

m secure your computer to a desk or table 

m lock the expansion bay module and battery in your computer 

See your Apple-authorized dealer or computer retailer for details on what
security devices are available.

Note:  You can protect the contents on your hard disk by turning on password
protection in the Password Security control panel. For information on this
control panel, see “How do I turn password security on and off?” in the
“Setting Options” section of Mac OS Help, available in the Help menu.

Sample locking device
with security cable

Battery

Expansion bay module

Security slot
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Using PC Cards (PCMCIA cards)

PC Cards (also known as PCMCIA cards) are about the size of a thick credit
card and have a 68-pin connector at one end. They come in many varieties,
such as fax/modem cards, mass-storage cards, Ethernet connection cards, and
wireless communication cards. You can use PC Cards to expand your
Macintosh PowerBook’s capabilit ies.

This section describes how to insert and eject PC Cards and how to set up
your communications software to use PC Card modems. For information on
using PC Cards, see the “Using PC Cards” topic area of Mac OS Help,
available in the Help menu.

Your Macintosh PowerBook has two PC Card slots: an upper slot and 
a lower slot. You can insert a card into either slot, or you can use both 
slots simultaneously.

There are three types of PC Cards. The different types refer to the thickness
of the card. A Type I card is 3.3 millimeters (mm) thick, a Type II card is 
5 mm thick, and a Type III card is 10.5 mm thick. Make sure you check the
documentation that came with your PC Card to verify that it is compatible
with your Macintosh PowerBook.

You can place a Type I or Type II card in either the upper or lower slot. You
can place a Type III card only in the lower slot. When a Type III card is in the
lower slot, you cannot use the upper slot. You may find it useful to get in the
habit of always using the lower slot to make sure the card you are using is
properly inserted. 

A special type of PC Card supports “Zoomed Video,” a method of showing
full-motion video images in a window on the computer’s screen. Your
PowerBook is designed to use a Zoomed Video card, but this type of card
must be placed in the lower PC Card slot.

WARNING  Make sure you only use cards that are designated by the PC
Card manufacturer as compatible with your Macintosh PowerBook. If
you use an incompatible card, you may damage the card or your
PowerBook. If you are not sure whether a PC Card is compatible with
your PowerBook, contact the PC Card manufacturer.
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Inserting a PC Card

To insert a card, do this:

m Insert the card, connector first and label up, into the slot. Make sure the card is level.

A Type III PC Card or a
Zoomed Video card must be
inserted in the lower slot.

A Type I or Type II PC Card can be
inserted in either the upper or lower slot.
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You’ll f eel some resistance as you slide the card in. When the card is fi rmly
seated, you will feel it click into place. Consult the card’s documentation for
details of its use.

An icon for the PC Card appears on the desktop.

You are now ready to use the card. 

Ejecting a PC Card

Your computer must be on or off to eject a PC Card. You cannot eject a PC
Card when the computer is in sleep. 

IMPORTANT  Before you eject a card, make sure that nothing is blocking the
card’s slot. If you want to use the card again immediately, pull it out about an
inch more and then push it back in. (If you don’t follow this procedure and you
try to push the card back in to use it again, the card will not engage properly.)

To eject a PC Card when the computer is on, follow these steps:

1 If the computer is in sleep, press the Power key (or any key on the keyboard except Caps
Lock) to wake it.

2 Click the PC Card’s icon to select it.

3 Choose Put Away from the File menu. 

4 Pull the card out of the slot.

IMPORTANT  Do not pull or force a PC Card out of the slot. Doing so may
damage your computer or PC Card.

Other ways to eject a PC Card when the computer is on include the following:

m Click the card’s icon to select it. Drag the card’s icon to the Trash. After the
card is ejected, pull it out of the slot.

m Click the card’s icon to select it. Open the Special menu and choose Eject
PC Card. After the card is ejected, pull it out of the slot. (If a dimmed icon
of the card remains on the desktop, you can drag it to the Trash.)
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To eject a PC Card when the computer is on or off, do this:

m Press the eject button next to the slot containing the PC Card you want to
eject. (The eject buttons do not work if your computer is in sleep.) If the
card is not in use, it will usually be ejected. If the card won’t eject, you’ll
see an alert message.

Try to use the eject buttons only when the computer is turned off. Many
PC Cards won’t eject when the button is pressed if the computer is on.

If you can’t eject a card

If you are unable to eject a card, follow these steps:

1 Straighten one end of a paper clip.

Press the eject button next to
the slot with the PC Card in it.
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2 Insert the end of the straightened paper clip into the hole next to the slot that contains
the card, and press gently but firmly until the card is ejected.

3 Pull the card out of the slot.

Setting the co mputer not to eject storage PC Cards at startup

If a you have a storage PC Card, such as an SRAM card or an ATA hard disk,
in either slot, the card will be ejected when the computer starts up. To prevent
excessive wear on PC Card connectors and slots, you can use the Startup Disk
control panel to keep storage PC Cards from ejecting when you turn on the
computer. (Other types of PC Cards, such as a modem or Ethernet card, are
not ejected at startup.)

Follow these steps to avoid having a storage PC Card eject at startup:

1 Open the Startup Disk control panel.

If you need instructions for opening the control panel, see “How do I make a
disk the startup disk?” in the Disks topic area of Mac OS Help, available in
the Help menu.

2 Click the icon for the computer’s hard disk to select it.

If you can’t eject a card, insert
the end of a straightened paper
clip into the hole next to the slot.
This hole is for the upper slot. 

This hole is for the lower slot.
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3 Close the control panel.

The PC Card storage device will no longer eject at startup.

Using a Zoomed Video PC Card

The lower PC Card slot in your Macintosh PowerBook has circuitry for handling
video signals, called “Zoomed Video.” Some independent manufacturers offer PC
Cards to which you can provide a video signal or connect a video camera. The
Zoomed Video PC Card is a Type II card; it can only be used in the lower slot
(because the special circuitry needed for video signals is located in that slot).

With a Zoomed Video card in the lower PC Card slot, the PowerBook can
display video on the computer’s screen or on an external monitor. Video
signals are sent directly to the video controller, so that the computer can
display full-motion video while performing other tasks at the same time.

If you purchase a Zoomed Video PC Card, be sure that it has software that
works with your PowerBook.

Using a PC Card modem

When you are using a PC Card modem, make sure you do the following:

1 Install the communications software you want to use, as well as any software that came
with your modem.

See the documentation that came with your modem and your communications
software for instructions on setting up a PC Card modem for each application.
Check to see if PC Card modem files for your software were included. You
can get other modem files from the manufacturer of your modem or your
communications software. 

2 Insert the PC Card modem.

When a PC Card modem is inserted, an icon like the one pictured below
appears on the desktop:

Some card manufacturers may use a custom icon.
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3 Plug your modem into a working phone line.

4 Follow instructions for setting up your modem with the communications software you
are using.

WARNING  When you connect a telephone line to your modem, make
certain that the phone line is the standard (analog) residential line, not a
digital line. Connecting a digital line to your modem card could damage it.
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Read this chapter for information on

expanding your computer system

with additional hardware.

The illustration below shows where equipment should be connected to your
Macintosh PowerBook. In most cases, you should refer to the manuals that
came with your equipment for instructions on connecting them. The safest
course is always to shut down your Macintosh PowerBook before you connect
any cable other than the power adapter, although you can connect external
devices to the sound port, printer/external modem port, or expansion card
while the computer is on.

´ Printer/External modem port

√ Sound input port

- Sound output port

¯ Power adapter port

V Apple Desktop Bus

Connector
for Ethernet/
modem or
Ethernet card

I Reset button
™ External monitor port

g SCSI port (HDI-30)

Infrared
window

Expansion card label
(ADB) port
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Additional information is provided in this chapter for adding the following
devices to your computer system:

m printers

m external modems

m SCSI devices

m external monitors

m sound input and output devices

m a mouse, keyboard, or other ADB device

m additional memory

m IR file transfer

Connecting a printer

The modem/printer port on your computer can accept either a direct
connection (to a printer such as a StyleWriter) or a LocalTalk network
connection (to a printer such as a LaserWriter). See the manual that came
with your printer for specif ic information about the type of connection 
it requires.

To connect a printer directly to your Macintosh PowerBook using the
modem/printer port, follow these steps:

1 Connect your printer as instructed in the manual that came with your printer. 

2 Open the Chooser from the Apple ( K) menu.

3 Turn off AppleTalk by clicking the Inactive button in the AppleTalk section.

If you are using an Ethernet connection or a network printer, you don’t have
to turn AppleTalk off.

4 In the Chooser, select the icon for the type of printer you connected.

If you need detailed instructions for using the Chooser, see “How do I select
a printer?” in the Printing topic area of Mac OSHelp, available in the Help menu.

The printer is ready to use.
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Connecting an external modem

You can use a PC Card modem in your computer’s PC Card slot. For
information on connecting and using a PC Card modem, see the
documentation that came with your modem, as well as “Using a PC Card
Modem” i n the section “Using PC Cards (PCMCIA Cards)” in Chapter 2 of
this manual, and the “Using PCCards” topic area of Mac OS Help, available
in the Help menu.

You can also connect an external modem to the modem/printer port on the
back panel of the computer. The modem/printer port is GeoPort-compatible.

To connect an external modem, follow these steps:

1 Make sure the computer is in sleep or shut down.

2 Connect the modem to a power source and to the phone line.

3 Make sure the modem is turned off.

4 Connect the modem cable to the port marked with this icon:

5 Turn on the modem.

6 Wake or restart the computer.

7 Open the Chooser and select the icon for a network printer (such as LaserWriter).

You must select a printer to be sure that the modem/printer port is available
for the modem.

8 Turn off AppleTalk in the Chooser.

If you see a message, click OK.

Note:  If you are using an Ethernet or infrared connection, you don’t need to
turn AppleTalk off.

The external modem is ready to use.
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Connecting SCSI devices

A SCSI device is any product—including hard disk drives, CD-ROM drives,
and scanners—that communicates with your computer by means of a
standard electronic interface. (SCSI stands for Small Computer System
Interface.) You can attach up to seven SCSI devices to your computer by
li nking them together in a chain that starts at your computer’s SCSI port.

To connect a SCSI device to your Macintosh PowerBook, you need an Apple
HDI-30 SCSI System Cable or equivalent. This cable is light gray, is about 19
inches long, and has 29 pins (one “missing” pin).

Refer to the manuals that came with your SCSI devices for instructions on
installing any necessary software, setting SCSI ID numbers, and connecting
SCSI cables and SCSI terminators. Refer to the illustrations on the next page
for the proper positioning of SCSI terminators. A SCSI chain of devices must
include a terminator attached to the first and last devices in the chain (but
nowhere else in the chain). Some devices include internal terminators. Your
Macintosh PowerBook is internally terminated.

The names and the part numbers of the cables mentioned in this chapter are
the following:

Type of connection Name of part Part number

From your computer to Apple HDI-30 SCSI System Cable M2538**/A
a SCSI device

From a SCSI device to Apple SCSI Peripheral Interface Cable M0207
a SCSI device

For SCSI disk mode Apple HDI-30 SCSI Disk Adapter Cable M2539**/A

WARNING  When connecting SCSI equipment, always turn off power to
all devices in the chain, including your computer. If you don’t, you
could lose information and damage your equipment.
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Where to add cable terminators when co nnecting a single SCSI device

Where to add cable terminators when co nnecting tw o or more SCSI devices

Using your Macintosh PowerBook as a hard disk

You can purchase a cable called the Apple HDI-30 SCSI Disk Adapter that
lets you connect your Macintosh PowerBook to another computer as a hard
disk. The PowerBook’s internal hard disk drive appears on the desktop of the
other computer as a hard disk icon, and you can transfer information between
the computers by dragging files. This feature is called SCSI disk mode.

The Apple HDI-30 SCSI Disk Adapter cable is dark gray, is about 10 inches
long, and has 30 pins.

IMPORTANT  Whenever you use your PowerBook in SCSI disk mode, be sure
that the power adapter is plugged in. If you connect the PowerBook as a SCSI
disk under battery power, the battery’s low-power warning will not be
displayed and the computer may shut down because the battery is drained.

SCSI peripheral interface cablesHDI-30 SCSI
system cable

Terminator
(If this SCSI device has an
internal terminator, omit
this external terminator.)

Terminator
(If this SCSI device has an internal
terminator, omit this external terminator.)

HDI-30 SCSI system cable
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Connecting your co mputer as a hard disk

Before making any connections, you need to assign a unique SCSI ID number
to the PowerBook. (The unique IDnumber allows the computer to
communicate with several connected devices.)

1 Choose Control Panels from the Apple ( K) menu of your PowerBook.

2 Open the PowerBook Setup control panel.

3 In the SCSI disk mode section of the control panel, click the ID number you want 
to assign.

If you are connecting the Macintosh PowerBook to an existing SCSI chain,
make sure to give it an ID number different from those of the other devices.
(Many devices include an ID number indicator on the back panel.)

4 Close the PowerBook Setup control panel.

5 Press the Power ( π) key on the PowerBook once to get the Shut Down dialog box and
click Shut Down to turn the PowerBook off.

6 Shut down the computer you are connecting to and turn off any other devices in the
SCSI chain.

7 Connect the small connector on the Apple HDI-30 SCSI Disk Adapter to the SCSI port on
your PowerBook.

WARNING  Always shut down the PowerBook before connecting or
disconnecting the SCSI disk adapter cable. Connecting the adapter cable
while the computer is turned on can damage the computer.
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8 If you are connecting the Macintosh PowerBook directly to the other computer 
(rather than to an external device in the SCSI chain), attach a SCSI system cable to 
the other computer. 

9 Connect the large connector on the Apple HDI-30 SCSI Disk Adapter cable to a SCSI
cable attached to the SCSI port on the last device in the SCSI chain, or to the SCSI
system cable on the other computer. 

10 Turn on the PowerBook by pressing the Power key.

After a few seconds a SCSI icon appears on the screen, showing the ID
number you assigned in step 3.

11 Turn on the other SCSI devices in the chain, if any.

12 Turn on the other computer.

The PowerBook’s internal drive appears as a hard disk icon on the screen of
the computer you connected it to. You can now transfer and use files as if the
Macintosh PowerBook were an external disk drive.

WARNING  If you do not see the SCSI icon, and the computer starts up
normally or displays an error message, press the Power key to shut down
(if you can) and then immediately disconnect your computer from the
SCSI chain. (If you can’t choose Shut Down, try pressing the reset button.
If you cannot shut down your Macintosh PowerBook, you should
disconnect the cable anyway, or you may lose information.) Then go
back and repeat steps 5 through 10, making sure to use the proper cables.

You may not be able to have password protection turned on in the
Password Security control panel while using your PowerBook in SCSI
disk mode. Turn password protection off if you experience problems.
See “How do I turn password security on and off ” i n the “Setting
Options” topic area of Mac OS Help, available in the Help menu.
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Drawing battery power in SCSI disk mode

Your Macintosh PowerBook continues to draw battery power when you use it
as a hard disk. Therefore, it is preferable to connect the power adapter
whenever you use the computer in SCSI disk mode.

In some instances a low power indicator may be displayed. This symbol is a
bli nking low-power warning on the PowerBook’s screen, like the icon below.

If you see this warning while using your computer as a hard disk, either plug
in the power adapter or quit SCSI disk mode, as described in the next section,
so you can recharge the battery.

Quitting SCSI disk mode

1 Shut down the computer your PowerBook is connected to.

2 Press the Power ( π) key once on the PowerBook to get the Shut Down dialog box.

3 Turn off any other SCSI devices in the chain.

4 Disconnect the PowerBook from the adapter cable.

IMPORTANT  Do not leave the adapter cable attached to the PowerBook. If you
do, the computer will behave as though it is still i n SCSI disk mode when you
try to restart.

5 If necessary, disconnect the adapter cable from the other computer or its SCSI chain.

Your equipment is now ready for normal use. If you disconnected the adapter
cable from the other computer or SCSI chain, make sure that the SCSI chain
is properly terminated.
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Using an external monitor

You can connect an external monitor to your Macintosh PowerBook. If you
are familiar with other PowerBook models, you will note that the types of
monitors you can use with this model and the way images are displayed on an
external monitor differ somewhat from other PowerBook computers.

To make the best choice of an external monitor, keep in mind the following
characteristics of your PowerBook’s hardware.

m Your PowerBook can support a variety of external monitors, including 
17-inch and 20-inch multiple-scan displays. Resolutions supported range
from 512 x 384 pixels to 1024 x 768 pixels. 

m The monitor port’s connector on the computer’s back panel is a VGA-style
connector. You can connect the cable for a VGA- or SVGA-style monitor
directly to your PowerBook.

m To connect an Apple (or Apple-compatible) monitor to your PowerBook,
you must use the adapter that came with the computer (it has the number
590-0289 molded into it).

m Images can appear on the internal display, the external monitor, or both
screens, depending on your choice of resolution on the external monitor.

m When an image appears on both screens, it is exactly the same (known as
“simulscan” or mirroring). You cannot move the pointer or menu bar from
one screen to the other (as you can when an external monitor is connected
to other PowerBook models or to most Macintosh desktop models).

m When an external monitor offers the same resolution as the PowerBook’s
internal display (800 x 600 pixels at 60 hertz [Hz] refresh rate), the image
appears on both screens the first time you turn on the computer (unless the
PowerBook’s display is closed).

m The PowerBook is designed to be “plug-and-play” when an external
monitor is attached. If the monitor is Apple-compatible, the PowerBook
tries to use the highest resolution possible. If the external monitor is not
Apple-compatible but provides a list of its capabilit ies, the system uses that
list of resolutions. If no list of resolutions is provided by the monitor, the
system uses a resolution of either 800 x 600 pixels or 640 x 480 pixels as
the default for that monitor.
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m If the PowerBook starts up with the display closed (called “docking mode”)
and an external monitor is attached, the PowerBook’s display does not turn
on and the display’s resolution (800 x 600) is not listed in the resolution
section of the Control Strip.

For complete instructions on adjusting the resolution for an external monitor,
see the “Monitors” topic area of Mac OS Help, available in the Help menu.

The list below shows the external monitors and the resolutions, refresh rates,
and number of colors supported by your PowerBook.

Monitor type Resolution Refresh rate (Hz) Number of colors †

12" RGB 512 x 384 60 256, thou, mil

13"/14" RGB Hi-Res 
& 12" Monochrome 640 x 480 67 256, thou, mil

VGA displays 640 x 480* 60 256, thou, mil

640 x 480 72 256, thou, mil

640 x 480 75 256, thou, mil

640 x 480 85 256, thou, mil

800 x 600 56 256, thou, mil

800 x 600 60 256, thou
(Simulscan for 
PowerBook screen)

800 x 600 72 256, thou, mil

800 x 600 75 256, thou, mil

800 x 600 85 256, thou, mil

1024 x 768 60 256, thou

1024 x 768 70 256, thou

1024 x 768 75 256, thou
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Monitor type Resolution Refresh rate (Hz) Number of colors †

Full-Page Monochrome 640 x 870 75 256

Full-Page RGB 640 x 870 75 256, thou

16" Color 832 x 624 75 256, thou, mil

19" Color 1024 x 768 75 256, thou

Apple 15" Multiscan 640 x 480 67 256, thou, mil

800 x 600 60 256, thou
(Simulscan for
PowerBook screen)

832 x 624 60 256, thou, mil

Apple 17" Multiscan 640 x 480 67 256, thou, mil

800 x 600* 60 256, thou
(Simulscan for
PowerBook screen)

832 x 624 75 256, thou, mil

1024 x 768 75 256, thou

Apple 20" Multiscan 640 x 480 67 256, thou, mil

800 x 600* 60 256, thou
(Simulscan for
PowerBook screen)

832 x 624 75 256, thou, mil

1024 x 768 75 256, thou

NTSC Display (Interlaced) 512 x 384* 60 256, thou, mil

640 x 480 60 256, thou, mil

PAL Display (Interlaced) 640 x 480* 50 256, thou, mil 

768 x 576 50 256, thou, mil 

* An asterisk indicates the startup resolution. Other resolutions can be selected using the Control Strip.
† thou = thousands of colors; mil = millions of colors
Note:  Your PowerBook supports the Video Electronics Standards Association (VESA) Display Data Channel (DDC)
Standard. Specifically, it supports the DDC2B transfer protocol. When a monitor supporting this standard is connected,
the PowerBook automatically recognizes the resolutions the monitor can display. You use the monitor resolution section
of the Control Strip or the Monitors & Sound control panel to change resolution.
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Connecting an external monitor

To connect an external monitor to your PowerBook, follow these steps. Also
consult the documentation that came with the monitor.

1 Press the Power ( π) key once to get the Shut Down dialog box.

2 Click Shut Down or Sleep.

If you connect a monitor with your computer turned on, the computer will
not recognize the monitor.

3 Place the monitor near the PowerBook.

Keep the computer and the monitor at least 8 inches apart. Interference
between the monitor and your computer’s floppy disk drive can cause errors
on your floppy disks.

Arrange the monitor so the top of the screen is slightly below eye level while
you work. Position the monitor to minimize glare and reflections on the
screen from lights and windows.

4 Make sure the monitor’s power cord is attached to the monitor. Plug the other end into a
grounded outlet or power strip.

If your monitor’s power cord is designed to plug into the power receptacle on
the back of a computer, rather than into an electrical outlet, you can obtain a
cord with the correct plug from your Apple-authorized dealer.

If you are using a power strip, make sure it is turned on.

5 If you are connecting an Apple or Apple-compatible monitor, locate the adapter that
came with your computer and attach it to one end of the external monitor’s cable.

The monitor adapter is a small plastic and metal device that is the same color
as the computer. The number 590-0289 is on the adapter.

If you are connecting a VGA or SVGA monitor, skip this step.

8 inches minimum

Floppy drive
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6 Make sure the other end of the monitor’s cable is attached to the monitor. Then attach
the end of the cable (with the monitor adapter, if it’s an Apple-compatible monitor) to the
external monitor port on the back of the PowerBook.

If you are connecting a VGA or SVGA monitor, do not use the adapter. Connect
the monitor cable directly to the external monitor port on the PowerBook.

7 Turn on the external monitor.

8 Press the Power ( π) key to turn on your computer. (You can press any key if your
PowerBook is in sleep.)

The external monitor is automatically activated. You can use the Control Strip
to change the resolution on the monitor. See the “Monitors” topic area of 
Mac OS Help, available in the Help menu, for instructions.

Trouble with the external monitor?
m Nothing happened when you tried to turn on the PowerBook.

Make sure that all your equipment is connected properly. Then try pressing
the Power (π) key again.

Make sure that the battery is charged, or that the power adapter is plugged
into both the computer and an electrical outlet. If you are using a power
strip, make sure it is turned on.

External monitor port

Monitor adapter

Monitor cable
(to Macintosh-compatible monitor)
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m The computer is on, but the external monitor is dark.

Make sure that the monitor’s power cord is connected and that its power
switch is on. Try adjusting the monitor’s brightness and contrast settings. If
this doesn’t work, try restarting your computer.

The external monitor will be dark if the PowerBook display is active and
simulscan is not active. The external monitor’s resolution must be set to
800 x 600 at 60 Hz for both screens to display the computer’s image; when
the external monitor is set to any other resolution, only one display is active.

Note:  The screen-dimming feature in the PowerBook control panel turns the
screen brightness down to a low level when you haven’t used the computer for
a few minutes. (You can think of dimming as “screen sleep.”) Dimming also
affects the external monitor. When you move your finger on the trackpad or
press a key on the keyboard, the brightness is restored on both screens.

Disconnecting an external monitor

1 Make sure your computer is shut down or in sleep.

2 Make sure your monitor is switched off.

3 Disconnect the monitor cable (for a VGA-style monitor) or monitor adapter (for an Apple
or Apple-compatible monitor) from the external monitor port on the computer’s back
panel. The port is marked with this icon: ™.

External monitor port

Monitor adapter
(for Macintosh-compatible monitor only)

Monitor cable
(no adapter used for VGA-style monitor)
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Connecting sound input and output devices

Your computer has a built-i n microphone. In addition, you can connect a
PlainTalk microphone to the sound input port. (You can also connect a standard
li ne-level input microphone, although it is not suitable for speech recognition.)

For information on using the microphone to record sounds, see the “Sound”
topic area of Mac OS Help, available in the Help menu.

Your Macintosh PowerBook also has a stereo sound input port (on the left
side of the computer’s case, marked with the √ icon) for connecting external
sound input devices that provide line-level output. You cannot use the internal
microphone and an external sound input device, such as a PlainTalk
microphone, at the same time. For instructions on selecting a sound device,
see the “Sound” topic area of Mac OS Help, available in the Help menu.

Microphone
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IMPORTANT  Although the internal microphone is deactivated when an
external sound input device is in use, it’s possible to record sound from more
than one sound device at the same time. This can occur because the computer
merges sound from devices in the expansion bay, such as an audio CD, with
sound from the PCCard slots, such as a television tuner card, and from the
internal expansion card slot (called PCI). If two or more devices in these
locations produce sound, the sound from all of the devices may be recorded
when you use the SimpleSound program or the Monitors & Sound control
panel to record. To elimi nate the sounds you don’t want to record, remove or
turn off the device producing those sounds.

The Macintosh PowerBook also has a stereo sound output port (on the left
side of the computer’s case, marked with the - icon) to which you can
connect externally powered speakers, an amplif ier, headphones, or other
audio output devices. The sound output port accepts a standard stereo
miniplug, like that used to attach headphones to a portable tape player.

Your computer also has four stereo speakers, which play sound from an audio
CD in the CD-ROM drive, from an external stereo device connected to the
computer through the sound input port, from a Zoomed Video card in the
lower PCCard slot, or from a file on your hard disk.

√ Sound input port
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You can adjust sound output quality in the Monitors & Sound control panel.
(For instructions, see the “Sound” topic area of Mac OS Help, available in the
Help menu.) The computer automatically selects the sound output source. If
an external device, such as headphones, is connected, sound is routed there; if
no external output device is connected, sound plays through the computer’s
four speakers.

You can also use the Control Strip to adjust sound volume.

Connecting a mouse, keyboard, or other ADB device

You can connect a mouse, keyboard, graphics tablet, or other Apple Desktop
Bus (ADB) device to the ADB port on the left side of the computer’s case,
behind the PCCard slots. The ADB port has a small cover, which you open
to connect the device.

IMPORTANT  You must shut down the computer or put it in sleep before
connecting an ADB device.

Connecting other devices

For instructions on connecting a device not discussed in this chapter—for
example, networking hardware—refer to the manuals that came with 
the device.

V Apple Desktop Bus
(ADB) port
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Adding memory to your co mputer

Your Macintosh PowerBook comes with 32 megabytes (MB) of random-
access memory (RAM). You can increase your computer’s memory by adding
a RAM expansion card. You can find out how much memory your computer
has by choosing About This Computer from the Apple (K) menu in the Finder.

You can purchase memory upgrades from Apple-authorized dealers. For
complete instructions on installing a RAM expansion card, see Appendix C.

Your Macintosh PowerBook also supports virtual memory, a feature that uses
hard disk space as if it were RAM. Your computer comes with virtual
memory turned on. For information on using virtual memory, see the
“Memory” topic area of Mac OS Help, available in the Help menu.

Using infrared f ile transfer

Your Macintosh PowerBook has built-i n infrared (IR) communication
features that allow you to send and receive data without wires. You can
exchange files with another PowerBook or with a desktop Macintosh that is
using an external IR module such as Farallon’s AirDock. In addition, you can
use IR to make a wireless connection to a network by means of a specialized
local area network (LAN) access device, such as Hewlett-Packard’s
NetBeamIR or Extended Systems’ JetEye, that is compatible with the Infrared
Data Association (IrDA) Standard specif ications.

To transfer files, your computer and the other IR device must be within range
of each other with the IR windows facing. The range depends on the devices
and the method of communication. 

Two PowerBook computers must be within 5 feet of each other to exchange
files using the IRTalk transfer protocol (at 230 kilobits per second). Your
computer must be within 3 feet of a LAN access device or another
PowerBook computer that complies with the IrDA Standards to make a
connection (at a transfer rate of 1 megabit per second).

You use the Infrared control panel to select the method of IR communication
you want to use or to view the status of an IrDA connection. For instructions
on IR file transfer, see “How do I use infrared communication?” in the
“Organizing Your Files” topic area of Mac OS Help, available in the Help menu.
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Power sources

Your computer can draw its operating power from three sources. 

m Main battery  Your computer came with a lithium ion (LiIon) battery. This
battery provides power for 2–4 hours of work time (you may get longer
work time, depending on the Macintosh PowerBook model you have and
the battery conservation features you use).

m Optional battery  Your computer can also use a nickel-metal-hydride (NiMH)
battery. This battery provides somewhat less work time than the LiIon
battery supplied with your computer. The precise amount of work time
with a NiMH battery depends on the Macintosh PowerBook model you
have and the battery conservation features you use.

m AC power  You can run your computer from a grounded electrical outlet 
by plugging in the external power adapter that came with your computer.
The installed battery will automatically be charged whenever the external
AC adapter is connected. The external adapter will charge the battery
more quickly if the computer is shut down or in sleep, rather than turned
on or operating.

IMPORTANT  Use only the external power adapter that came with your
computer (model number M4895) or one made specif ically for this
PowerBook model.
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In addition, the PowerBook contains a rechargeable backup cell to keep
system information such as date and time. The backup cell i s automatically
recharged whenever the external AC adapter is connected. The backup cell
also provides up to 4 minutes of power during system sleep while you change
the main battery. (See “Removing or Replacing the Battery” later in this
chapter for more information about changing batteries.)

Monitoring the battery charge

There are four ways you can determine the charge level of your battery:

m Look in the battery monitor portion of the Control Strip.

For information on the battery monitor, see the “Batteries & Power” topic
area of Mac OS Help, available in the Help menu.

m See low-power messages on your display.

m Look at the battery level icon next to the clock in the menu bar.

m Look at the battery level indicator lights on the battery, visible when the
battery is out of the computer.

Responding to low-power messa ges

When the battery runs low, the computer displays a series of low-power
messages. The work time remaining after you see the first message 
varies depending on how you are using the computer. It’s a good idea to 
act promptly.

What you should do

When you see a low-power message, you should do the following:

1 Plug in the power adapter, or

2 Save your work and shut down the computer, then

3 Quickly replace the empty battery with a charged one (within 30 seconds, if possible).

IMPORTANT  Always save your work when you see a low-power message.
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What you should know

When the first low-power message appears, the screen dims automatically to
save power. 

If you continue to work without plugging in the power adapter or changing
the battery, the computer displays a second low-power message indicating that
the computer is about to put itself to sleep. Within a few seconds, the
computer goes to sleep automatically to protect the contents of RAM. All
activities are interrupted. It’s a good idea to save your work when you see the
first low-power message to make sure you don’t lose information. 

If you continue working until the computer goes to sleep automatically, you
can wake it again as soon as you plug in the power adapter or replace the
battery with a charged battery. 

If you can’t plug in the power adapter, the contents of RAM are retained in
sleep for about a day (as long as you don’t remove the battery).

IMPORTANT  Recharge a depleted battery as soon as possible. Leaving a
depleted battery in the computer for a length of time (especially in a hot
location, such as the trunk of a car) may damage the battery so that it can’t
be recharged. If this happens, you need to replace the battery.

Using the battery icon

There is a battery icon in the menu bar that tells you the charge left in 
your battery.
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Using the battery level indicator lights (on a lithium ion battery only)

You can tell the charge left in your LiIon battery by looking at the battery
level indicator lights on the battery itself. Follow these steps to determine the
charge level:

1 Save your work and then shut down the computer or plug in the power adapter.

2 Pull the battery out of its compartment.

For instructions on removing the battery, see “Removing or Replacing the
Battery” later in this chapter.

3 Push the battery level indicator button to activate the battery level indicator lights.

The lights show whether the battery is fully charged, three-fourths charged,
one-half charged, one-fourth charged, or empty (not shown in the
illustration). A lighted square indicates that the battery has power; an
unlighted square (black in the illustration) indicates lack of charge. The
indicator lights remain lit for a few seconds.

IMPORTANT  If the battery lights are bli nking, there’s a problem with the
battery. See an Apple-authorized service provider for assistance.

You can purchase a second battery from an Apple-authorized dealer, so that
you have a backup source of power when you can’t use the AC adapter.

Battery level indicator button

Battery level indicator lights

Fully charged

3/4 charged

1/2 charged

1/4 charged

52 Chapter  4



Recharging the battery

To recharge the battery, plug in the power adapter. Your computer’s batteries
may be charged inside the computer. You may also use an external battery
charger designed specif ically for your model of the Macintosh PowerBook.

Note:  It is normal for the computer to start up when power is applied and the
PowerBook has been in storage or the battery is discharged or has been
removed from the computer.

A lightning bolt icon appears in the battery monitor portion of the Control
Strip when the power adapter is plugged in and a battery is recharging. 

The battery is recharged regardless of whether you are using the computer, or
the computer is off or in sleep; however, it will recharge more quickly if the
computer is off or in sleep.

WARNING  Use only the external power adapter that came with your
computer or one made specif ically for this PowerBook model. Adapters
for other electronic devices (including other portable computers) may
look similar, but they may damage your computer. 

Power cord

Power adapter

Power adapter plug

¯ Power adapter port
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Removing or replacing the battery

To remove or replace the battery, follow these steps:

1 Save your work and then shut down the computer or put it to sleep, or plug in the 
power adapter.

2 Close the display.

3 Press the battery release button on the battery.

4 Pull the battery out of its compartment.

5 Put the battery cap on the battery to protect the battery contacts.

The battery contacts should not be exposed when the battery is out of 
the computer.

Battery cap

Always snap the battery cap on the battery
when the battery is out of the computer.

1 Press the button on the battery. 2 Slide the battery out.
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6 If you are inserting another battery, remove the battery cap from the new battery to
expose the contacts, then slide it into the battery compartment. 

You cannot insert a battery if the battery cap is still on the battery. You can
replace the battery with another LiIon battery. Make sure you only use a
battery that is designed for your Macintosh PowerBook. You should store the
battery cap in case you want to remove and transport the battery later.

IMPORTANT  If you take out the main battery while the computer is in sleep
and it is not connected to an external power adapter, you must insert another
battery within 30 seconds or you may lose any unsaved work.

7 If you just inserted a new battery, it’s a good idea to plug in the power adapter in case
the battery is not fully charged. You can look at the indicator lights on the battery to see
the level of charge.

IMPORTANT  Lithium ion (LiIon) and nickel-metal-hydride (NiMH) batteries
contain metals and other substances which are hazardous when released in
the environment. It is inappropriate, and in some cases unlawful, to throw
batteries away with your household or business trash. Instead of throwing
away your spent batteries, dispose of them as described here

m In the United States Return spent batteries to your Apple-authorized 
service provider, who will make sure they are included in Apple’s battery
recycli ng program.

m Elsewhere  Many locations have government or Apple-sponsored collection
or recycli ng programs for spent batteries. Dispose of spent batteries in
accordance with the mandatory or voluntary battery collection programs 
in your location. Contact your Apple-authorized service provider for
information about the recommended disposal procedures in your area.

Lithium-ion
(Li-ion)

Nickel-metal 
hydride (NiMH)
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Maximizing work time

Your Macintosh PowerBook’s battery can provide 2–4 hours of work time
before you need to recharge. The actual work time available depends on
which model of Macintosh PowerBook you have, what equipment you’re
using with your computer, and what steps you take to conserve power while
you work.

Some battery-saving measures you can take include the following:

m Mi nimize backlighting of the display.

m Turn off AppleTalk if your PowerBook is not connected to a network.

m Set the hard disk to spin down after a very short interval.

m Remove PCCards and CDs when they are not in use.

m Take advantage of the sleep feature of your PowerBook whenever your
work is interrupted (such as when the cellular phone rings). You just need
to close the display to put the computer in sleep.

For more battery conservation tips, see the “Batteries & Power” topic area of
Mac OS Help, available in the Help menu.
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When you have questions

If you want to know how to do a particular task with your computer, refer to
Mac OS Help in the Help menu. If the suggestions in this chapter and Mac
OS Help don’t solve the problem, go to Chapter 6 for instructions on some
general diagnostic techniques.

When you run into trouble

While you’re using your computer, you may see a bomb icon or an error
message, or you may have a problem such as the pointer (8) “freezing” on the
screen. If you have trouble with your computer, take a few minutes to read the
information in this chapter and Chapter 6. If your problem is related to a
particular procedure, you should also look for information on that procedure
in Mac OS Help, available in the Help menu. If you are unable to access Mac
OS Help (for example, if your screen is “frozen”), refer to this chapter to see
if you can resolve the problem. 

This chapter and Chapter 6 describe solutions to problems you may
experience with your computer. If the suggestions in these two chapters don’t
solve your problem, contact a local Apple-authorized service provider or call
the Apple Assistance Center. (See the service and support information that
came with your computer for the telephone number.) If your problem is with
third-party software or equipment, please call the software or equipment
manufacturer for help.
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Consult this chapter if you have

questions or experience 

problems using your computer.



Problems starting up the co mputer

The computer doesn’t start up.

m The battery may need recharging. Plug the power cord into a working
outlet and then plug the power adapter into the computer. Let the battery
recharge for a few minutes.

m Check that the power cord is plugged into a working outlet. If it’s plugged
into a power strip, make sure the power strip is turned on. The power
adapter should get warm after being plugged in for 10 minutes. If it is 
cold, make sure the adapter is securely plugged in and attached to 
the power cord.

m The screen brightness may be turned down. Adjust the brightness control
(marked with the icon ¤) located above the top row of keys on the
keyboard, to the right of center.

m Make sure the battery is properly seated in its compartment. 

m If none of these measures helps, you may need to reset the computer. The
method of resetting you should always try fi rst is to press the Command
(x), Control, and Power keys simultaneously. If the computer does not start
up, connect the power adapter (if it is not already connected) and press the
reset button (marked with the icon I) on the back panel.

m If the reset described in the previous paragraph does not start up the
computer, remove the battery and unplug the power adapter and hold in
the reset button for 30 seconds. Then reconnect the power adapter and put
in the battery and try starting up again.

I Reset button
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The sleep indicator light at the top of the display glows a steady green.

You must reset the computer using the reset button. Connect the external
power adapter (if it is not already connected) and press the reset button
(marked with the icon I) on the back panel.

When the reset procedure is used the computer will thoroughly test the RAM,
so it may take a few moments (about 1 second per megabyte of RAM) before
the screen lights. Be patient if you have added expansion RAM.

The computer makes an unusual sound at startup, or you see a “sad Macintosh” icon.

m If you hear the sound of breaking glass when you turn on the computer or
you see a “sad Macintosh” i con, start up the computer with the PowerBook
CD that came with your computer. If the computer does not start up, or if
the hard disk icon does not appear, the hard disk may need repair. Contact
an Apple-authorized service provider or call the Apple Assistance Center.
If the hard disk icon does appear, see Chapter 6 for information about
reinstalling the system software.

m There may be a problem with the information stored in the area called
parameter RAM (PRAM). Reset the PRAM (also called “zapping 
the PRAM”) . 

Resetting the PRAM erases the contents of your RAM disk, if you have
one. Resetting the PRAM also restores the default settings in most control
panels. After you reset the PRAM, be sure to check any custom settings
you made for the desktop pattern, memory, network, AppleTalk, trackpad,
power conservation, and so forth. Resetting the PRAM also resets the
power manager.

Follow these steps to reset the PRAM:

1. Locate the keys Command (x), Option, P, and R. 

2. Make sure the Caps Lock key is not down.

3. Restart your Macintosh (using the Command [x], Control, and Power
keys or the reset button, if necessary). Immediately after hearing the
startup sound, press the Command (x), Option, P, and R keys
simultaneously. 

If you don’t hold down the key combination within 5–10 seconds after
you restart, you may need to repeat steps 1–3. 

4. Hold down the keys until you hear the startup sound again. 

59Tips and Troubleshoot ing



5. If the computer shuts itself off, press the Power key to turn it back on.

6. When the computer has finished starting up, restore any custom control
panel and network settings.

m If nothing happens after you reset the PRAM, there may be a problem with
a RAM expansion card. If you installed a RAM expansion card in your
computer, check Appendix C to make sure the card is properly installed. If
you purchased an expansion card from a third-party manufacturer, contact
the manufacturer for help.

See also “The Computer Makes Unusual Sounds” i n the section “Other
Problems While Working” later in this chapter.

The computer starts up, but the desktop doesn’t appear.

m The screen brightness may be turned down. Adjust the brightness control
(¤), located above the top row of keys on the keyboard, to the right of center.

m The computer may be trying to start up using an external hard disk that
does not contain the correct system software. Disconnect the external hard
disk and restart your computer. (This can also happen with PCCard drives
and expansion bay drives.)

m Start up the computer, holding down the Shift key until you see the
message “Extensions off ” i n the “Welcome to Macintosh” box. If the
computer starts up, turn to Chapter 6 and try the steps given in the section
“Checking Your System Software Extensions.” You can go directly to the
Extensions Manager control panel by holding down the Space bar during
startup.

When you start up the computer, you see a message about the system software.

m The system software on the startup disk you’re using may be incomplete or
damaged, or may be the wrong version. Make sure you’re using the correct
disk as a startup disk. (You can start up from the CD that came with your
computer by pressing the letter “c” as the computer starts up.)

m If you’re sure you’re using the correct startup disk, you may need to
reinstall system software. See “Reinstalling System Software” i n Chapter 6.
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The computer displays a flashing question mark icon. 

m This icon usually means that the computer can’t find system software on
any disks attached to the computer. If the computer is connected to any
external hard disks, make sure they are turned on. Then restart the
computer. If the problem recurs, the hard disk or its system software may
be damaged. See Chapter 6.

m Turn off the computer, disconnect all external devices except the power
adapter, and restart the computer. If the computer starts up, turn to
“Problems with Equipment Connected to Your Computer ” later in 
this chapter.

The computer freezes or displays an error message during startup.

m Turn off the computer, disconnect all external devices except the power
adapter, and restart the computer. If the computer starts up, turn to
“Problems with Equipment Connected to Your Computer” later in 
this chapter.

m Start up the computer, holding down the Shift key until you see the
message “Extensions off ” i n the “Welcome to Macintosh” box. If the
computer starts up, turn to Chapter 6.

About the codes in error messages:  The number codes in error messages are
used in software development. Sometimes they can help a technician narrow
down the source of a problem. However, the codes are usually too general or
technical in nature to help you diagnose a problem yourself.

When the computer starts up, a message says there is not enough memory.

There may not be enough memory to load all the system software extensions
you’ve installed. Restart the computer, holding down the Shift key until you
see the message “Extensions off ” i n the “Welcome to Macintosh” box. Then
try the following to increase available memory:

m Turn on virtual memory in the Memory control panel, or increase the
virtual memory size if it’s already on. Your PowerBook can deliver good
performance with virtual memory set to two to three times the amount of
actual RAM i n the computer.
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m Reduce the size of the disk cache in the Memory control panel.

m If you use a RAM disk, reduce its size or turn it off in the Memory 
control panel.

m Use the Extensions Manager control panel (in the Control Panels folder
inside the System Folder on your hard disk) to turn off extensions you don’t
need. Then restart the computer. (You can use Extensions Manager to
create different sets of extensions for special situations.)

You need to restart the computer for these changes to take effect. 

If these suggestions don’t work, you can increase memory by installing a
RAM expansion card in your computer. See Appendix C for information.

The computer won’t restart.

m If the computer freezes, you can try to “force” the program you’re using 
to quit by simultaneously pressing the keys Command (x), Option, and 
Esc on your keyboard. Then click Force Quit in the dialog box that
appears. (Note:  Unsaved changes in your current documents will be 
lost.) Immediately save all open documents, quit all other open programs,
and restart the computer.

m You may need to reset the computer. The method of resetting you should
always try fi rst is to press the Command (x), Control, and Power keys
simultaneously. If the computer does not start up, connect the power
adapter (if it is not already connected) and press the reset button (marked
with the icon I) on the back panel. 

Note:  You will lose any work you have not saved. 

m If the problem recurs, reset the parameter RAM (see “The Computer
Makes an Unusual Sound at Startup, or You See a ‘Sad Macintosh’ I con,” i n
the section “Problems Starting Up the Computer” earlier in this chapter). If
the problem still occurs, see Chapter 6.

Every time the computer starts up, it rebuilds the desktop.

There may be a folder on your hard disk that has the same name as a file the
computer uses to keep track of information on your disks. Manually search
for a folder named “Desktop” or “Desktop file.” If you find one, rename it
“Storage.” Then restart the computer. (Do not use the Find File feature to
search for the desktop file. It may find it but you may not be able to access it.)
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When you start up the computer, the display lights up for a moment, then shuts down. 

m Make sure you are using the correct power adapter for your 
computer model.

m If the computer is running on the battery, make sure the battery is charged.
Or connect the external power adapter.

The computer won’t wake after the battery was replaced with the computer in sleep and
without the power adapter plugged in.

m Connect the power adapter and press the Power key (or any other key
except Caps Lock) to wake the computer.

Tip:  Leave the power adapter plugged in and charging the system for at
least 24 hours to ensure that the backup battery is charged enough to allow
battery replacement during computer sleep.

Problems working with programs
The computer freezes or displays a system error message. 

m There may be a temporary software problem. To reset the computer, try the
following suggestions in order until the computer starts up normally:

1. If the computer freezes, you can try to quit the program you’re using by
pressing the keys Command (x), Option, and Esc on your keyboard.
Click Force Quit in the dialog box that appears. (You’ll l ose unsaved
changes in that program’s documents.) 

Immediately save all open documents and quit all open programs, then
restart the computer. 

2. If you see a message about a system error, you may need to reset the
computer. The method of resetting you should always try fi rst is to press
the Command (x), Control, and Power keys simultaneously. If the
computer does not start up, connect the power adapter (if it is not
already connected) and press the reset button (marked with the icon I)
on the back panel. 

Note:  You will lose any work you have not saved. 
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3. Reset the PRAM (see “The Computer Makes an Unusual Sound at
Startup, or You See a ‘Sad Macintosh’ I con,” i n the section “Problems
Starting Up the Computer” earlier in this chapter for instructions).

m If the problem recurs, it may involve one or more of your application
programs. See “The Computer Exhibits Odd Behavior, Such as Many
Unexplained System Failures,” next.

About the codes in error messages:  The number codes in error messages are
used in software development. Sometimes they can help a technician narrow
down the source of a problem. However, the codes are usually too general or
technical in nature to help you diagnose a problem yourself.

The computer exhibits odd behavior, such as many unexplained system failures.

m Check for multiple System Folders on your startup disk, using the Find File
command. Throw away extra System Folders (but do not throw away any
System Folders from your RAM Disk Backup folder). The System Folder
that your computer is using has a Mac OS logo on it.

m Check for viruses on all your disks, using a virus-detection program.
Eliminate any viruses the program finds.

m If a problem recurs when you are using a particular program, try 
the following:

m Consult the documentation that came with the program to make sure you
are using it correctly.

m Check for multiple copies of the program on your hard disk. Use the Get
Info command to check the programs’ version numbers. Keep one copy
of the latest version and throw away all other copies.

m Reinstall the program from a known good source (such as the original
program disks or the CD that came with your computer).

m Increase the program’s memory. Quit the program, select its icon, choose
Get Info from the File menu, and type a larger number in the Preferred
Size box.
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m Contact the manufacturer or vendor of the program to find out whether
the program contains software errors or “bugs” and whether an upgrade
is available.

m Check that the program is compatible with the version of system
software your computer is using. (See the program’s documentation, or
contact the manufacturer or vendor.) You can find out which version of
software you have by choosing About This Computer in the Apple (K) menu.

m Make sure your control panels and system software extensions
(especially any that you recently added) are compatible with your
programs. See Chapter 6.

A program won’t open.

m The application program may already be open. Check the Application
menu to see which programs are running.

m There may not be enough memory available to open the program. Quit any
programs you’re not using and try again. If that doesn’t work, try restarting
the computer. 

m If the program is on a floppy disk, make sure the disk is unlocked. (You
unlock a disk by sliding the tab at the corner of the disk so that it covers
the hole.)

m The program may be damaged, or it may not be compatible with PowerPC
technology. Check to make sure the software is PowerPC-compatible, and
install it from a known good source (such as the original program disks).

m Contact the manufacturer or vendor of the program to see if the program is
compatible with the version of system software your computer is using.
(Choose About This Computer from the Apple [K] menu to see which
version of system software you have.)

A program suddenly quits or disappears, or a message says a program has quit.

m There may be a temporary software problem. Restart the computer, then
try opening the program again.

m The program may have run out of memory. See the suggestions in 
“A Message Says There Is Not Enough Memory,” next.

m If the problem occurs when you are trying to print, there may not be
enough memory for printing.
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m Contact the manufacturer or vendor of the program to see if the program
contains software errors or “bugs” and if it is compatible with the version
of system software you’re using.

A message says there is not enough memory.

m There may be a temporary software problem. Save your work, quit all open
programs, and restart the computer. If you can’t use the Restart command,
see the suggestions in “The Computer Freezes or Displays a System Error
Message,” earlier in this section.

m If you get this message when you are trying to open or use a program,
follow these steps:

1. Choose About This Computer from the Apple (K) menu. Take note of
the number in the Largest Unused Block section. This number tells you
how much memory is available to open programs.

2. Quit the program if it’s open, select its icon, and choose Get Info from
the File menu. Take note of the numbers in the Minimum Size and
Preferred Size boxes. 

3. If the number in the Minimum Size box is larger than the largest unused
block, not enough memory is available to use this program. To free
memory, quit open programs or restart the computer. You can also type
a smaller number in the Minimum Size box if you want to open the
program using less memory. (But some programs don’t work well if you
assign them less memory.) 

4. If the number in the Preferred Size box is smaller than the largest
unused block, you may need to assign more memory to the program. (A
program may need more memory if you are working with complex
documents.) Type a larger number in the Preferred Size box.

m If you frequently want to open more programs than memory allows, try 
the following: 

m Turn on virtual memory in the Memory control panel or increase the
amount of virtual memory if it is already on.

m Use the Memory control panel to reduce the size of the disk cache or
remove or reduce the size of your RAM disk.

m Install a RAM expansion card in your computer. See Appendix C 
for instructions.
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When you try to open a document, a message says the program can’t be found. 

m The document may have been created with a program that is not on your
hard disk, or with a different version of the program.

m You can also open a document from within a program by using the Open
command in the File menu. For more information, see the documentation
that came with your programs.

m If you know the correct program is on your hard disk, there may be a
problem with the information that the computer uses to keep track of files.
Restart the computer and hold down the Command (x) and Option keys
until you see a message asking if you want to rebuild the desktop. Release
the keys and click OK.

Note:  If you have Macintosh Easy Open installed, you must use the
Extensions Manager control panel to turn off all extensions except the
Macintosh Easy Open control panel, and then follow the previous steps to
rebuild your desktop.

A window has disappeared.

m Another open window may be covering the one you’re looking for. Move,
resize, close, or hide windows until you see the one you want.

m The program the window is associated with may be hidden. Choose Show
All fr om the Application menu, then click the window you want, or choose
the program from the Application menu.

Other problems while working

The screen went blank.

m Screen dimming may be on. Move the pointer to restore the screen’s
brightness. You can adjust the interval before screen dimming takes effect,
or you can turn screen dimming off, using the PowerBook control panel.

m The computer may have gone to sleep, as indicated by the bli nking sleep
LED at the top of the display. Press the Power key (or any key except Caps
Lock or the trackpad button) on the keyboard to wake it. 

m The battery may be drained. Install a charged battery, or plug in the power
adapter and let the battery charge for a few minutes. Then try to wake or
start up the computer.
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Some icons look different from usual. 

m There may be a problem with the information that the computer uses to
keep track of files. Restart the computer and hold down the Command (x)
and Option keys until you see a message asking if you want to rebuild the
desktop. Release the keys and click OK. 

Note:  If you have Macintosh Easy Open installed, you must turn off all
extensions except the Macintosh Easy Open control panel, and then follow
the previous steps to rebuild your desktop.

m You may be using a file-compression program to save space on your hard
disk. Some compression programs change the appearance of icons. 

When trying to open or move a font file, you see an error message. 

The font file may be damaged. To remove damaged font files, follow 
these steps: 

1. Drag the Fonts folder out of the System Folder.

2. Restart the computer. 

3. Open the Fonts folder that you dragged out, and drag undamaged fonts to
the System Folder icon. Click OK in the dialog box.

4. Throw away the old Fonts folder.

5. Reinstall the damaged font from the original disk.

An icon is blinking in the menu bar.

A program needs attention. Open the Application menu and choose the
program whose icon is bli nking (it may have a diamond by its name).
Respond to any messages on the screen. If it’s not clear what you should do,
consult the documentation that came with the program.

A file can’t be thrown away.

m The file may be locked. Select the file’s icon, then choose Get Info from
the File menu and click the Locked checkbox to remove the X. You can
delete locked files that are in the Trash by holding down the Option key
while you choose Empty Trash from the Special menu.

m An application program may be using the file. Close the file or quit 
the program.
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m If the file is on a floppy disk, the disk may be locked. Unlock the disk by
sliding the tab so that it covers the hole at the corner of the disk.

m The file may be in a shared folder that can’t be changed. You can throw
away the file by turning off file sharing temporarily (click Stop in the File
Sharing control panel). Or you can select the shared folder, choose Sharing
from the File menu, and uncheck the box labeled either “Can’t be moved,
renamed, or deleted” or “Same as enclosing folder.”

The computer makes unusual sounds. 

m A program may need your attention. If an icon is bli nking in the menu bar,
open the Application menu, choose the program whose icon is bli nking 
(it may have a diamond by its name), and take the necessary action. 

m Open the Easy Access control panel (if it i s installed on your computer)
and check whether any features are turned on. 

m Select a different system sound in the Sound control panel.

m The computer sound hardware periodically turns itself off to save power.
Sometimes this causes a clicking or popping noise. This sound is normal.

m If the sounds are regular or melodic, they may be caused by interference
from electrical equipment. Move the computer farther away from any such
equipment. 

See also “The Computer Makes an Unusual Sound at Startup, or You See a
‘Sad Macintosh’ I con,” i n the section “Problems Starting Up the Computer”
earlier in this chapter.

You can’t access some of the memory on your computer. 

m All computers set aside some memory for system overhead.

m If you want to open more programs than memory allows, you can use the
Memory control panel to decrease the size of the disk cache, or remove or
decrease the size of the RAM disk (if you’re using one). You can also have
a memory expansion card installed in your computer.
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Problems with hardware

RAM or cache diagnostic error

You see a message that a problem was detected with RAM or cache memory.

If you see this type of error message, take your computer to an Apple-
authorized service provider. Ignoring this condition could lead to random
errors and failure that could result in your losing data. (Although the error
message may not reappear, the problem detected during the computer’s self-
check probably has not gone away.)

Floppy disk drive

You can’t eject a floppy disk.

The disk may be stuck. Restart the computer, holding down the trackpad
button. If the disk is not ejected, you can eject it manually. Carefully insert
the end of a straightened paper clip into the small hole near the disk drive’s
opening, and push firmly until the disk is ejected.

Insert the end of a
large, straightened
paper clip into
this hole.
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You can’t save or copy files onto a floppy disk.

m The disk may be locked. Unlock it by sliding the tab at the corner of the
disk so that it covers the hole.

m The disk may be full. Throw away items on the disk that you no longer
need, or save the files on a different disk.

m The disk or disk drive may be damaged. Test it with Disk First Aid (on the
CD that came with your computer or in the Utilit ies folder on the hard disk).

Hard disk drive

The computer won’t start up from the internal hard disk, or the hard disk icon doesn’t
appear on the desktop.

There may be a temporary software problem. Turn off the computer, wait at
least 10 seconds, and then turn it on again.

The hard disk keeps stopping and starting again.

The hard disk may be going to sleep to conserve power. Use the PowerBook
control panel to change the power conservation settings. 

The computer is using the wrong disk as a startup disk.

m Open the Startup Disk control panel and make sure the correct disk is
selected. Then restart the computer. 

m If you’re trying to start up from an external hard disk, the computer may
not be recognizing the disk. See “Problems With Equipment Connected to
Your Computer,” later in this chapter.

m There may be a problem with your startup disk or with its system software.
See “Testing Your Hard Disk” i n Chapter 6.

Trackpad 

The pointer won’t move.

m A program may be doing some work. Wait a few moments and then 
try again.

m A temporary software problem may have caused the computer to “freeze.”
See “The Computer Freezes or Displays a System Error Message” i n the
section “Problems Working With Programs,” earlier in this chapter.
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The pointer sticks or jumps when you use the trackpad.

Make sure to use only one finger on the pad and that your finger is dry.

Keyboard

Typing on the keyboard produces nothing on the screen.

m Make sure the program you’re using is set to accept text input. Usually you
need to set an insertion point or select some text before typing. If you’re
using a communications program, you may need to turn on the “local
echo” setting.

m Open the Easy Access control panel and make sure Slow Keys is 
turned off.

m Open Key Caps in the Apple (K) menu and check whether the computer is
recognizing keyboard input. If so, the keys in the Key Caps window will
indicate when keys are pressed on the keyboard.

A key won’t stop repeating.

Open Key Caps in the Apple (K) menu. If any keys in the window are
darkened, keys may be stuck down on your keyboard.

PowerBook display

The screen went blank.

m Screen dimming may be on. Move the pointer to restore the 
screen’s brightness.

m The computer may have gone to sleep. Press any key (except Caps Lock)
on the keyboard to wake it.

m The battery may need recharging. Plug in the power adapter, let the 
battery charge for a few minutes, and then try to wake or start up the
computer again.

m If an external monitor is connected, the image may be displayed on that
monitor and not on the PowerBook’s display. (If the external monitor is set
to a different resolution from the 800 x 600 pixels of the PowerBook
display, the computer’s image only appears on the external monitor.)
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The screen flickers. 

m Adjust the brightness control (¤).

m Open the Monitors & Sound control panel or use the Control Strip to set
the computer to display fewer colors or grays. 

m If tilt ing the display affects the flickering, there may be a loose cable.
Contact an Apple-authorized service provider, or call the Apple 
Assistance Center at the number provided in the resource materials that
came with your computer.

The computer freezes when screen dimming takes effect. 

Screen dimming does not work with some programs. Contact the program’s
manufacturer to see if there is a newer version of the program that is
compatible with dimming. If the problem persists, you can open the
PowerBook control panel and turn off screen dimming.

External monitors

The monitor remains dark. 

Shut down the PowerBook, then make sure the monitor is connected to the
PowerBook, plugged into an active outlet, and turned on. (Most monitors
have a light on the front panel to show whether they are on.)

The monitor is on, but no image appears. 

m Use the Monitors & Sound control panel to select a resolution that will
display on the external monitor. If the resolution is not 800 x 600 at 60 Hz,
the PowerBook’s screen goes blank when the external monitor is in use.

m Screen dimming may be on. Move the pointer to restore the 
screen’s brightness.

m Adjust the monitor’s brightness and contrast controls.

m Use the Control Strip to change the resolution on the external monitor. If
you still don’t see an image, there may be a problem with the monitor.

m If you are using an Apple monitor with a 15-pin connector, be sure that the
video adapter that came with your computer is connected (between the
monitor cable and the PowerBook’s external monitor port).
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The monitor goes dark after a few minutes. 

Screen dimming may be turned on. Move the pointer to restore the screen’s
brightness. You can change the interval before screen dimming takes effect in
the PowerBook control panel.

The computer freezes when screen dimming takes effect. 

Screen dimming does not work with some programs. Contact the program’s
manufacturer to see if there is a newer version of the program that is
compatible with dimming. If the problem persists, you can open the
PowerBook control panel and turn off screen dimming.

There is wavy or jittery interference on the external monitor. 

This interference may be generated by a magnetic field. If the monitor is near
another piece of equipment (such as a TV, speakers, or another monitor),
move the monitor away from the equipment.

You connected a different external monitor and it turns on but doesn’t display an image.

Once you set the resolution for an external monitor, any other external
monitor subsequently connected to your PowerBook will attempt to use that
resolution. If you cannot set a resolution for the new external monitor that
results in an image on the screen, you may need to detach the second monitor,
discard the Display Preferences file (in the Preferences folder inside the
System Folder), reconnect that monitor, and choose a resolution over again to
see a satisfactory image. For instructions, see the Monitors topic area of 
Mac OS Help, available in the Help menu.)

Printers

The computer can’t find the printer.

m Make sure the printer is connected and turned on.

IMPORTANT  Make sure that all equipment is turned off before connecting or
disconnecting cables.

m The printer may not be selected in the Chooser. Open the Chooser and
select the printer you want to use. If the printer is connected to a port,
make sure the correct port is selected.
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m Reset the parameter RAM. (See “The Computer Makes an Unusual Sound
at Startup, or You See a ‘Sad Macintosh’ I con,” i n the section “Problems
Starting Up the Computer” earlier in this chapter for instructions.) Then
select the printer in the Chooser and try printing again.

The printer does not appear in the Chooser.

m Make sure you’ve selected the correct kind of printer on the left side of the
Chooser window. For example, if you’re using a StyleWriter II, make sure
to select StyleWriter II, not StyleWriter.

m Use the scroll bars to look through all the selections in the Chooser windows.

m Check the connections between your computer and the printer, including
relevant sections of the network if appropriate. (See “Problems With
Networks and File Sharing” later in this chapter.)

m Make sure the correct printer software is in the Extensions folder inside
your System Folder.

m If you’re using a network printer, make sure that AppleTalk is active in the
Chooser. If you are using a printer connected directly to your computer,
make sure AppleTalk is inactive, or the Printer/External modem port is not
selected in the AppleTalk control panel.

m If your network has zones, make sure the zone containing your printer 
is selected.

Nothing happens, or an error message appears, when you try to print.

m There may not be enough memory for printing. Try the following:

m Quit the program immediately after sending the Print command.

m Increase the amount of memory that Desktop PrintMonitor uses. (Locate
Desktop PrintMonitor in the System Folder, select it, choose Get Info
from the File menu, and type a larger number in the Preferred Size box.)

m Reduce the amount of memory the program uses.

m Make sure the printer is turned on. Some printers need to warm up for a
few minutes after you turn them on.

m The printer may be out of paper or may need attention. Check the printer
status lights and any messages on your screen. 

m Open the current printer (its icon has a bold outli ne) and check for 
status messages.
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m Reinstall your printer software. 

m Reset the parameter RAM. (See “The Computer Makes an Unusual Sound
at Startup, or You See a ‘Sad Macintosh’ I con,” i n the section “Problems
Starting Up the Computer” earlier in this chapter for instructions.) 

SCSI equipment and SCSI disk mode

External SCSI equipment doesn’t work, or a hard disk icon does not appear on 
the desktop.

m You may not be able to use password protection with your PowerBook in
SCSI disk mode. Turn password protection off in the Password Security
control panel.

m Check that all cables are connected securely, that the devices are plugged
into working outlets, and that the devices are turned on. 

IMPORTANT  Make sure that all equipment is turned off before connecting or
disconnecting cables.

m Make sure that you turn on SCSI equipment before you start up the
PowerBook.

m Check that each connected SCSI device has a unique ID number 
between 0 and 6. 

m Make sure that SCSI cable terminators are correctly positioned. Follow the
instructions in “Connecting SCSI Devices” i n Chapter 3.

You can’t turn on the computer after connecting a SCSI device.

m Turn on the SCSI equipment fi rst, and then turn on the computer.

m Try disconnecting the SCSI equipment to determine if the computer will
start up. If not, see the beginning of this chapter.

When you start up using SCSI disk mode, the desktop appears. 

When you use SCSI disk mode, the computer should display an icon with a
number in it.
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If the computer starts up normally, immediately press the Power key to shut
down (if you can) or turn off the computer. If you don’t, you might damage
your information or equipment.

m Make sure you are using the correct cable for SCSI disk mode. The HDI-30
SCSI Disk Adapter is about 10 inches long, is dark gray, and has 30 pins in
the connector (no “missing” pins). Do not use the HDI-30 SCSI System
Cable, which is light gray, is about 19 inches long, and has 29 pins in the
connector (one “missing” pin). That cable is for connecting SCSI
equipment to your PowerBook.

m Check that all cable connections are secure.

m The PowerBook’s battery may be drained. Plug in the power adapter and
let the battery charge for a few minutes. Then press the Power key on the
PowerBook’s keyboard to restart it, and restart the other Macintosh.

m Start up the other Macintosh with the CD or Disk Tools floppy disk that
came with it (do not use the CD that came with your PowerBook). If the
connection works, then a system software extension on the other Macintosh
may be causing the problem. 

When you start up using SCSI disk mode, you see a flashing question mark icon. 

m Make sure you are using the correct cable for SCSI disk mode. The HDI-30
SCSI Disk Adapter is about 10 inches long, is dark gray, and has 30 pins in
the connector (no “missing” pins). Do not use the longer, light gray HDI-30
SCSI System Cable.

m Make sure terminators are placed correctly in the SCSI chain. For more
information, see “Connecting SCSI Devices” i n Chapter 3.

The Macintosh you are connected to in SCSI disk mode doesn’t see the PowerBook.

m You cannot use the PowerBook in SCSI disk mode if password protection 
is turned on. Turn password protection off in the Password Security 
control panel.
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m Make sure you are using the correct cable for SCSI disk mode. The HDI-30
SCSI Disk Adapter is about 10 inches long, is dark gray, and has 30 pins in
the connector (no “missing” pins). Do not use the longer, light gray HDI-30
SCSI System Cable.

m Make sure terminators are placed correctly in the SCSI chain. For more
information, see “Connecting SCSI Devices” i n Chapter 3.

m Check that there is no conflict between SCSI ID numbers among all
devices in the SCSI chain. If necessary, you can change the ID for your
computer in the PowerBook control panel.

m Start up the other Macintosh with the CD or Disk Tools floppy disk that
came with it (do not use the CD that came with your PowerBook). If the
connection works, then a system software extension on the other Macintosh
may be causing the problem.

Problems with equipment co nnected to your co mputer

If a problem occurs while your Macintosh PowerBook is connected to
equipment such as SCSI equipment, an external monitor, a modem, a printer,
a mouse, or a keyboard, these steps may help you determine the source of
the trouble:

1 Shut down or turn off your Macintosh PowerBook and anything that’s connected to it.
Disconnect everything connected to your Macintosh PowerBook (except the power
adapter) and restart it.

Note:  If you’re connected to a network, contact your network administrator or
warn other users before disconnecting from the network, because it may
interrupt network services.

If the problem does not recur, it is likely related to equipment connected to
your PowerBook.

2 Shut down the Macintosh PowerBook.

3 Reconnect one device.

4 Make sure that the device is plugged into a working outlet and turned on, if applicable.

5 Start up the Macintosh PowerBook.

6 Repeat steps 2–5 until the problem recurs. The last device you connected may be
causing the problem.
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Problems with networks and f ile sharing 

Solutions to co mmon problems

If you are having problems using the network or file sharing, try the following
before attempting further solutions:

m Make sure that AppleTalk is turned on in the Chooser.

m Open the AppleTalk or TCP/IP control panel and make sure the correct
network connection is selected. 

m Whenever you make a change in the AppleTalk or TCP/IP control panel,
be sure to close that control panel so that the change takes effect.

m Make sure that all the network software is installed. If you aren’t certain
that all networking software is installed, you can use the Custom option of
the Installer program on the CD that came with your computer to reinstall
all network software. 

m Make sure the network is working by opening the Chooser and checking
for the shared disks and printers you usually use.

m Try connecting to the network from a different location, or connecting a
printer or another computer directly to the PowerBook using network
cables. If that works, the problem is likely to be in the network. If it doesn’t
work, the problem may be in the PowerBook or its network software.

Solutions to other problems

The computer you want to connect to doesn’t appear in the Chooser. 

m Make sure the computer you’re trying to connect to is turned on.

m Make sure file sharing is active on the computer you’re trying to connect to.
(That computer’s File Sharing control panel should say that file sharing 
is on.)

You connected to another computer, but the shared disk you want to use is not available.

m You may already be connected to the shared disk. Check for its icon on
your desktop.

m You may not have the access privileges you need to use the shared disk.
Ask the network administrator or the owner of the shared item to give you
access. (See the “Sharing Files” topic area of Mac OS Help, available in the
Help menu.)

79Tips and Troubleshoot ing



You connected to another computer, but you can’t see any files.

m Make sure that files are being shared on the other computer. The File
Sharing control panel on that computer lists the items being shared.

m Make sure you have the access privileges you need to view the files. Ask
the network administrator or the owner of the shared item to give you
access. (See the “Sharing Files” topic area of Mac OS Help, available in the
Help menu.)

A message says that a disk can’t be ejected because it’s being shared. 

When you have file sharing turned on, you can’t eject disks (other than floppy
disks) that were connected to your computer when you started it up. You can
eject the disk by turning off file sharing in the File Sharing control panel.
Af ter you’ve ejected the disk, you can turn file sharing back on.

A message says that file sharing can’t be turned on. 

m Make sure AppleTalk is turned on in the Chooser.

m Make sure you have at least 1 MB of available space on your hard disk. 

m Some disk-formatting programs don’t work with file sharing. If you use such
a program, contact the manufacturer or vendor for compatibility i nformation.

m There may be a problem with some of the information your computer 
uses to start up file sharing. Follow these steps in order until the problem 
is solved:

1. Open the File Sharing control panel and enter new information in the
Owner section. Then try again to turn on file sharing. 

2. Remove the File Sharing folder from the Preferences folder (inside the
System Folder). Then restart the computer and try to turn on file sharing.

3. Reset the parameter RAM. (For instructions, see “The Computer Makes
an Unusual Sound at Startup, or You See a ‘Sad Macintosh’ I con,” i n the
section “Problems Starting Up the Computer”earlier in this chapter.)
Afterward, make sure to turn AppleTalk back on and select the correct
network type in the Network control panel.

4. Remove the Users & Groups data file from the Preferences folder
(inside the System Folder). Restart the computer.

5. Reinstall system software.
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A message says that an item can’t be shared. 

m Make sure you have at least 1 MB of space available on your hard disk. 

m Some removable storage devices can’t be shared. Check with the
manufacturer or vendor of the device for more information.

m Some disk-formatting programs don’t work with file sharing. If you use
such a program, check with the program’s manufacturer or vendor.

The file-sharing section doesn’t appear in the File Sharing control panel. 

m You may have turned off AppleTalk or file sharing using the Extensions
Manager control panel or the Chooser. Turn them back on.

m If the file-sharing and network software is not in your System Folder, use the CD
that came with your computer to reinstall file-sharing and network software.

You can’t open a shared disk or folder.

m You may not have the access privileges needed to use the disk or folder. Ask
the network administrator or the owner of the shared item to give you access.

m Check with the owner of the item to make sure you are entering your name
exactly as specif ied by the owner (including spaces and capitalization) and
try again.
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Problems with Apple Remote Access

The Remote Access Setup control panel won’t open.

m Make sure that AppleTalk is turned on in the Chooser.

m If you still can’t open the control panel, reinstall the Apple Remote 
Access software.

The modem is not listed in the Remote Access Setup control panel. 

m Reinstall the modem software. If that doesn’t help, then reinstall the Apple
Remote Access software. 

m If you are using a PC Card modem, make sure the modem file for your
modem is in the Modem Scripts folder inside the Extensions folder (in the
System Folder). If it is not, check the software that came with your modem.
If you locate a file for your modem, put it in the Modem Scripts folder.

m Contact the modem manufacturer to see whether your modem can use the
settings for another type of modem.

The modem didn’t dial the phone number.

m Check that the phone cord is plugged into the computer and into a working
phone line. 

m Try dialing the number again. Sometimes there is a temporary 
connection problem.

m Quit the program and restart it. Sometimes this procedure solves
temporary problems with the modem.

m Another program may be using the modem. Quit all other programs that
use the modem. 

m Try using another communications program. If that works, the problem
may be in the Apple Remote Access software. Reinstall the software.

82 Chapter  5



The modem dialed the phone number, but the connection failed. 

m Check that the phone cord is plugged into the computer and into a working
phone line.

m Make sure your modem is plugged into an analog phone line. Do not use a
digital phone line. 

IMPORTANT  Digital phone lines can damage your modem. 

m Check with your Apple Remote Access administrator to make sure your
version of Apple Remote Access is compatible with the version on the
computer you’re calling. If you’re using a version of Apple Remote Access
later than 1.0, you can use the Remote Access Setup control panel to set
your software to work with version 1.0.

You’re connected via Apple Remote Access but you can’t see any shared disks. 

m Open the Chooser and click the AppleShare icon. Shared disks should
appear on the right side of the Chooser. If you still don’t see any shared
disks, and your Chooser has a box labeled “Zones,” choose a different zone
(some networks don’t have zones). 

m If there are still no shared disks, or you can’t connect to the one you want,
contact your Apple Remote Access administrator or the owner of the
computer you want to connect to.

Whenever you try to use Apple Remote Access, a message says it’s not installed correctly. 

m This message sometimes appears if AppleTalk is turned off. Make sure
AppleTalk is turned on in the Chooser.
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This chapter provides a step-by-step approach to diagnosing and solving
problems involving system software and hard disks. Try the steps listed in
each section in the order they are given until your problems are fixed.

Checking your system software extensions

System software extensions are files that add features to your system software.
Some extensions are incompatible with one another or with certain programs.
To check whether an extension is causing problems, follow these steps:

1 Start up the Macintosh PowerBook while holding down the Shift key. Keep it held down
until you see the message “Extensions off” in the “Welcome to Macintosh” box. 

This procedure turns off extensions.

If this procedure solves your problem, then continue with this section. If not,
then turn to the next section, “Testing Your Hard Disk.”
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2 Restart the computer while holding down the keys Command ( x), Option, P, and R until
you hear the startup sound repeat itself three times. Then release the keys.

This procedure resets the parameter RAM. For more information, see “The
Computer Makes an Unusual Sound at Startup, or You See a ‘Sad Macintosh’
Icon,” i n the section “Problems Starting Up the Computer” in Chapter 5.

If the problem does not recur, it may involve file sharing, virtual memory, or
the disk cache. Turn these features back on one at a time (restarting the
computer each time) until the problem recurs. You may be able to fix the
problem by making the disk cache smaller or using a smaller amount of
virtual memory. If the problem involves file sharing, contact your network
administrator to make sure there are no network problems.

3 Turn off troublesome extensions using the Extensions Manager control panel.

Tips for locating problem extensions:

m If you recently installed a new item in the System Folder, it may be causing
the problem. If you recently installed a new application program, a new
extension may have been installed along with it. Check for new items in
the Extensions folder and Control Panels folder. Also check for items of the
kind “extension” or “control panel” i n the System Folder itself.

m If two of your extensions provide similar features (such as two screen
savers or two clocks), they may be incompatible with each other. Remove
one of the extensions.

m If the computer is freezing or displaying an error message before it finishes
starting up, restart the computer and take note of the icons that appear at
the bottom of the screen. Many extensions display an icon as they start up,
and extensions start up alphabetically. The last extension that displays an
icon, or the one after it alphabetically, may be the problem extension.

4 Turn extensions back on, one extension at a time, in the Extensions Manager control
panel. Restart the computer after turning on each extension and test to see if the
problem recurs. 

When you have located the problem extension, remove it from the System
Folder and contact the developer or vendor for compatibility i nformation.

5 Go to the next section if you are still having problems.
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Testing your hard disk

The following steps will help you determine whether you have a problem
with your hard disk or a problem with the system software on your hard disk.

1 Start up the Macintosh PowerBook with the system software CD that came with your computer.

If the computer starts up normally, you may have a problem with the system
software on your hard disk. If the computer starts up but you don’t see the
hard disk icon, you may have a problem with the hard disk.

If the computer doesn’t start up normally, you may have a problem with
equipment connected to your Macintosh PowerBook. See “Problems With
Equipment Connected to Your Computer” in Chapter 5. 

If nothing is connected, your computer may need repair. Contact an Apple-
authorized service provider, or call the Apple Assistance Center.

2 Open the Drive Setup icon .

You may need to look in a folder called Utilit ies to find Drive Setup.

Note:  You can get onscreen help using the Drive Setup application program
by choosing the Drive Setup Guide, available in the Help menu when 
Drive Setup is running.

3 In the list of drives, click the disk you want to test.
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4 Open the Functions menu and choose Test Drive.

5 When a message tells you that testing is complete, click Quit.

If you cannot repair the disk, you may need to reinitialize the disk using the
Drive Setup program.

6 If testing indicates that no repair is necessary, but you’re still having a problem with your
computer, go to the next section.

Reinstalling system software

When should you install system software?

Your computer came with all the necessary system software installed on its
internal hard disk, so you don’t need to install system software on that disk
unless you encounter software problems.

If you have a new hard disk or a newly initialized hard disk that doesn’t
contain system software, or if you want to upgrade to a more recent version of
system software on a hard disk, follow the instructions in “Installing Mac OS 8”
later in this chapter.

If you have a problem with your system software, you may see this icon in the
middle of the screen:

If this icon appears, follow the instructions in “Testing Your Hard Disk”
earlier in this chapter to test your startup hard disk and repair any damage. 

If repairing the disk doesn’t help, follow the instructions in “I nstalling 
Mac OS 8” to reinstall system software on your startup hard disk.

WARNING  Reinitializing the hard disk erases all the information on it. 
If you don’t have a recent backup of your information, an Apple-
authorized service provider may be able to recover some of the
information before you reinitialize the hard disk.
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Restoring custom settings and special software

Your computer came from the factory with 

m additional applications

m system software settings

m the Mac OS Info Center customized for your computer

When you reinstall system software using the Mac OS 8 Install program
described in this chapter, it will not reinstall bundled applications, reset
customized settings, or provide customized information about your computer. 

If you want to restore your computer to its custom settings, use the restore
program that is included on your system software CD. Follow these steps:

1 Restart your computer using your system software or restore CD, as described in the
next section.

2 Follow the instructions in the Read Me file for more information about restoring your
system software or bundled applications.
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Using a CD to start up your co mputer

Before you reinstall software onto your hard disk, you need to start up your
computer with the CD-ROM containing system software. This allows the 
Mac OS Install program to repair any problems on your hard disk and update
the disk driver before you install the software.

Before you begin the installation, do the following:

m Turn off any virus-protection software and disk-security software you 
may have.

m Plug in the power adapter and set the computer so it doesn’t go to sleep.

m Turn off password protection in the Password Security control panel.

Follow these steps to start up from the CD containing system software.

1 Press the Open/Close button of your CD-ROM drive to open the CD-ROM tray.

2 Place the CD-ROM disc containing system software in the tray with the disc label 
facing up.

Make sure the disc is lying flat in the tray.

3 Close the CD-ROM tray by pushing in the tray or pressing the Open/Close button.

4 Hold down the C key on your keyboard while you choose Restart from the Special menu
and wait for the message “Welcome to Mac OS” to appear.

5 When you see the screen that says “Mac OS” and the phrase “Starting Up,” release the 
C key.

In a few seconds the desktop appears. Your computer is now using the system
software that’s on the CD-ROM disc. You’ll know you’ve started up from the
CD-ROM disc if you see the CD-ROM disc icon at the top-right corner of the
desktop, above your hard disk icon. The desktop pattern will also be different.

90 Chapter  6



Installing Mac OS 8

After you’ve started up your computer using the CD-ROM disc, use the 
Mac OS Install program to install the software.

1 Double-click the Mac OS Install icon.

After a moment, a screen appears describing the four steps in the 
installation process.

The Mac OS Install program guides you through the steps necessary to install
the software. To learn more about each step, click the Help (h) button in the
upper-right corner of the window.
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2 When you’re ready to begin, click Continue and follow the instructions you see on the screen. 

Note:  The Mac OS Install program automatically runs the applications Drive
Setup and Disk First Aid before starting the installation process. Prior
versions of system software required that you run these applications
separately. If you need information on how to use these applications, choose
Drive Setup Guide or Disk First Aid Guide when each application is running.

As part of the normal software installation process, the Mac OS Install
program replaces changed system files and adds new ones, but leaves others
alone. In addition, the Mac OS Install program provides an option for doing a
clean installation of system software. 

IMPORTANT  You should only perform a clean installation if you have already
tried reinstalling system software as described in this section and are still
experiencing the same problems with your system. For more information on
when you should do a clean installation, see “Performing a Clean
Installation” later in this chapter.

Responding to messa ges about your hard disk

The Mac OS Install program checks the destination hard disk for errors
before installing the software. If your hard disk was formatted with an Apple
disk utility program, the Installer updates the hard disk drivers with the latest
version of the driver software. If your disk was formatted with a disk utility
from another company, the drivers are not updated. You should use the 
third-party disk utility to update your hard disk before installing Mac OS 8.
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Selecting which software to install

The Mac OS Install program installs the basic components of the system
software along with additional software features such as QuickDraw 3D and
Personal Web Sharing. 

Af ter you select a drive for installation, you will see these choices:

m Reinstall Mac OS 8

Select this option if you need to reinstall system software to solve system
software problems or repair a damaged hard disk. This process is known as
a standard installation. If you select this option, go to the next section,
“Select Software to Install Using a Standard Installation.”

m Add or remove software features

Select this option if you want to install specif ic components of Mac OS 8
or additional software features. You can also use this option to selectively
remove software components. This process is known as a custom
installation. If you select this option, skip ahead to the section “Select
Software to Install or Remove Using a Custom Installation.”

For most computer users, the standard installation is best, because it
automatically installs everything you need for your model of computer.
However, if you’d like to select only the software specif ic to your needs, you
can customize your installation. You can install or update one or more
specific files, or save space on your hard disk by installing only the files you want.
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Select software to install using a standard installation

The next step in the installation process is to select the software that you want
to install along with Mac OS 8.

1 Select the software to install along with Mac OS 8.

The Install Mac OS 8 window provides a list of items that you can select or
deselect. Boxes that are already selected are those items that are normally
installed as part of the Mac OS.

2 Click Start.

Mac OS 8 along with any additional software you selected is now installed on
your computer. 

3 After you’ve installed all the software you selected, restart your computer.
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Select software to install or remove using a custom installation

The next step in the installation process is to select the software that you want
to install along with Mac OS 8. 

1 Select the software to install, the software to remove, or both.

As you proceed in the custom installation process, you’ll b e able to determine
exactly which components will be installed or removed for the software you select. 

When performing a custom installation you can choose whether to install
Mac OS 8. If you select Mac OS 8, you will be able to add or remove specif ic
components of Mac OS 8, such as fonts and printer drivers. 

2 Click Start. 

The Installer for the first software product you selected appears. You’ll use
the Installer to specify which components of the product you want to install.

3 When you see the Installer’s welcome screen, click Continue.

If you want all the recommended components for this product, click Install.
Then skip to step 8.

If you want to install specif ic components of the software, or remove the
software, follow steps 4 through 6 below. 
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4 Open the pop-up menu and choose a menu item.

m If you want to install software, choose Custom Install.

m If you want to remove software, choose Custom Remove.

All available components for the software product appear in the 
Installer’s window.

5 Scroll through the list of components and click the checkbox next to each component
you want to install or remove.

You can see and select individual items within each component by clicking
the arrow to the left of the component, then clicking the item you want to
install. To get additional information about each component listed, click the
box with the letter i in it to the right of the component.
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6 Click Install or Remove.

If you are installing software, the selected items will be installed on your
computer. If you are removing software, the selected items will be deleted
from your computer.

The Installer may also remove or delete associated files that are required for
the items you choose.

7 Repeat steps 4 through 6 for all the software you selected. 

After you finish installing or removing a software product, the Installer for
the next product you selected opens automatically.

8 After you’ve installed all the software you selected, restart your computer.

Problems during installation

This section helps you solve problems you may encounter while installing
your software.

You can’t start up the computer using the system software CD-ROM disc. 

Cause:  Your computer located the system software on your hard disk before it
located the system software on the CD. If you have an external hard drive with
system software, the computer may have started up from that device instead of
the CD-ROM disc.

Solution:  With the CD in the drive, open the Startup Disk control panel and
click the CD icon. Then restart the computer. 

You’ll n eed to reselect your hard disk as the startup disk after you install the
software. Open the Startup Disk control panel again and click the icon for
your hard disk. Then restart your computer.
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The Installer cannot repair your hard disk.

Cause:  The Mac OS Install program is unable to repair a problem with your
hard disk. 

Solution 1:  If you see a message that the disk can’t be fixed because a file is
open or file sharing is on, make sure that you have started up your computer
from the system software CD. See “Using a CD to Start Up Your Computer”
earlier in this chapter.

Solution 2:  Use a third-party disk repair utility to repair the disk. 

If you don’t have a third-party utility, or if that utility can’t repair the disk
either, you may need to reinitialize the hard disk.

First, back up your hard disk because reinitializing erases everything on the
disk. Then use the Drive Setup utility program to reinitialize the disk. If your
hard disk is not an Apple hard disk, use the disk utility software provided by
the manufacturer instead of Drive Setup.

You can find Drive Setup in the Utilit ies folder on your system software 
CD-ROM disc. To reinitialize your startup disk (the disk with system software
on it), you need to start up the computer from a different disk. You can start
up using your system software CD-ROM disc. See “Using a CD to Start Up
Your Computer” earlier in this chapter for instructions.

After you’ve reinitialized the disk, use the Mac OS 8 Install program to
reinstall system software. Then reinstall your application programs. 

You see a message that there’s not enough disk space.

Cause:  Your computer’s hard disk has less than the minimum amount of
space required to install the software.

Solution:  Make more space available on your hard disk by removing some
files from the disk. Make backup copies of the files, if desired. Then drag
them to the Trash and choose Empty Trash from the Special menu. You don’t
need to quit the Installer before you remove the files from the disk.

When you see this message, some of the software you selected may have been
installed. The Install Software window in the Installer program indicates
which software has already been installed.
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You see a message that the System file cannot be modified. 

Cause 1:  You have installed virus-protection software that guards against
modification of the System file.

Solution 1:  Start up your computer from your system software CD-ROM disc
as described in “Using a CD to Start Up Your Computer” earlier in this chapter.

Solution 2:  Drag any virus-protection software out of the System Folder and restart
your computer. You can put the virus-protection software back after installation.

Cause 2:  The System and Finder files may be locked.

Solution:  Make sure that you have started up from the CD. Then, to see if
your System file or Finder file is locked, select the file’s icon. Then open the
File menu and choose Get Info. To unlock the file, click the Locked checkbox
to remove the mark.

Performing a clean installation

This section provides instructions for what is commonly called a clean
installation of system software.

A normal system software installation replaces changed system files and adds
new ones, but leaves other files alone. When you install system software using
a clean installation, the Installer creates a new System Folder on your hard
disk. The old System Folder is renamed Previous System Folder. Since your
computer has a new System Folder, you must reinstall any third-party
extensions and control panels after a clean installation. Application programs
and documents are not replaced or changed.

Performing a clean installation can be a complicated procedure, but if you are
experiencing problems or your computer seems slow, it may help.

If your computer came with software that was already installed, some of those
programs might need to be reinstalled after you perform a clean installation.
See the printed or electronic manuals that came with the software for information.
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Follow these steps to perform your clean installation.

1 Start up your computer from your system software CD-ROM disc, as described in “Using
a CD to Start Up Your Computer” earlier in this chapter.

2 Open the Mac OS Install program.

3 In the Welcome dialog box, click continue.

The Select Destination dialog box appears.

4 Click the Perform Clean Installation checkbox so that it has a mark in it.

5 Click Select.

6 Select the software products you want to install.

For more information about the choices available, or for instructions on
further customizing your selections, see “Selecting Which Software to Install”
earlier in this chapter.

7 Click Start to install the software you’ve selected.

A new System Folder is installed on your hard disk. (The old System Folder is
renamed Previous System Folder.) 
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When the Mac OS Installer is finished, you can reinstall extensions, fonts,
control panels, and other items not installed with Mac OS 8 from their
original disks. If you don’t have the original disks, you can drag or copy these
items one at a time from the Previous System Folder to the new System
Folder. Restart your computer after you reinstall each item to make sure the
software is compatible with Mac OS 8.

After you’re sure that you’ve copied all the items you want to save into your
new System Folder, delete the Previous System Folder from your hard disk.
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Health-related information about co mputer use

Muscle soreness, eye fatigue, and other discomforts and injuries sometimes
associated with using computers can occur from performing any number of
activities. In fact, misuse of the same muscles during multiple activities can
create a problem that might not otherwise exist. For example, if you engage 
in nonwork activities that involve repetitive stress on the wrist—such as
bicycli ng—and also use your computer’s keyboard improperly, you may
increase your likelihood of developing wrist problems. Some individuals 
are at greater risk of developing these problems because of their health,
physiology, lifestyle, and general exposure to stress. Work organization and
conditions, such as workstation setup and lighting, also play a part in your
overall health and comfort. Preventing health problems is a multifaceted task
that requires careful attention to the way you use your body every hour of
every day.

The most common health effects associated with using a computer are
musculoskeletal discomfort and eye fatigue. We’ll di scuss each area of
concern in this appendix.
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Musculoskeletal discomfort

As with any activity that involves sitting for long periods of time, using a
computer can make your muscles sore and stif f. To minimize these effects, set
up your work environment carefully, using the guideli nes that follow, and take
frequent breaks to rest ti red muscles. To make working with your computer
more comfortable, allow enough space in your work area so that you can
change position frequently and maintain a relaxed posture.

Another type of musculoskeletal concern is repetitive stress injuries (RSIs),
also known as cumulative trauma disorders (CTDs). These problems can
occur when a certain muscle or tendon is repeatedly overused and forced into
an unnatural position. The exact causes of RSIs are not totally understood, but
in addition to awkward posture, such factors as the amount of repetition, the
force used in the activity, the individual’s physiology, workplace stress level,
and lifestyle may affect the likelihood of experiencing an RSI.

RSIs did not suddenly arise when computers were invented; tennis elbow and
writer’s cramp, for example, are two RSIs that have been with us for a long
time. Although less common than other RSIs, one serious RSI discussed more
often today is a wrist problem called carpal tunnel syndrome, which may be
aggravated by improper use of computer keyboards. This nerve disorder
results from excessive pressure on the median nerve as it passes through the
wrist to the hand.

This section offers advice on setting up your work area to enhance your
comfort while you use your computer. Since the effects of repetitive
movements associated with using a computer can be compounded by those 
of other work and leisure activities to produce or aggravate physical problems,
proper use of your computer system must be considered as just one element
of a healthy lifestyle.

No one, of course, can guarantee that you won’t have problems even when you
follow the most expert advice on using computer equipment. You should
always check with a qualified health specialist if muscle, joint, or eye
problems occur.
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Eye fatigue

Eye fatigue can occur whenever the eyes are focused on a nearby object for a
long time. This problem occurs because the eye muscles must work harder to
view an object that’s closer than about 20 feet (6 meters). Improper lighting
can hasten the development of eye fatigue. Although eye fatigue is annoying,
there’s no evidence that it leads to permanent damage.

Whenever you’re engaged in an activity that involves close-up work—such as
reading a magazine, doing craft work, or using a computer—be sure to have
sufficient glare-free lighting and give your eyes frequent rest breaks by
looking up and focusing on distant objects. Remember to have your eyes
examined regularly.

To prevent discomfort and eye fatigue:

m Arrange your work space so that the furniture is properly adjusted for you
and doesn’t contribute to an awkward working posture.

m Take frequent short breaks to give your muscles and eyes a chance to rest.

Arranging your work area and equipment

The suggestions in this section can help you work more comfortably with
your computer.

Chair

m An adjustable chair that provides firm, comfortable support is best. Adjust
the height of the chair so your thighs are horizontal and your feet flat on
the floor. 

The back of the chair should support your lower back (lumbar region).
Follow the manufacturer’s instructions for adjusting the backrest to fit your
body properly.
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Keyboard and trackpad
m When you use the keyboard and trackpad, your shoulders should be

relaxed. Your upper arm and forearm should form an approximate right
angle, with your wrist and hand in roughly a straight line. 

m You may have to raise your chair so your forearms and hands are at the
proper angle to the keyboard. If this makes it impossible to rest your feet
flat on the floor, you can use a footrest with adjustable height and tilt to
make up for any gap between the floor and your feet. Or you may lower
the desktop to elimi nate the need for a footrest. Another option is to use a
desk with a keyboard tray that’s lower than the regular work surface.

m Use a light touch when typing or using the trackpad and keep your hands
and fingers relaxed. Avoid rolli ng your thumbs under your palms.

This Not this

Not thisThis

106 Appendix  A



Some computer users may develop discomfort in their hands, wrists, or arms
after intensive work without breaks. If you begin to develop chronic pain or
discomfort in your hands, wrists, or arms, consult a qualified health specialist.

m Change hand positions often to avoid fatigue.

m If you prefer, you can adjust the angle of the keyboard by lowering the
elevation feet until they snap into position.

The back of the keyboard is slightly elevated when the feet are in use.
Otherwise, the keyboard is level.

Mouse
m If you use an external mouse, position the mouse at the same height as

your keyboard. Allow adequate space to use the mouse comfortably.

Built-in display
m Adjust the angle of the display to minimize glare and reflections from

overhead lights and windows.

m You may need to adjust the brightness and contrast of the screen when you
take the computer from one work location to another, or if the lighting in
your work area changes.

To lower the foot, press the release
button. The foot extends automatically. 

To raise the foot, press the release button while
pushing up on the foot until it clicks into place. 
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External monitor

If you use an external monitor, this suggestion may be helpful.

m If possible, arrange the monitor so the top of the screen is slightly below
your eye level when you’re sitting at the keyboard. The best distance from
your eyes to the screen is up to you, although most people seem to prefer
18 to 28 inches (45 to 70 cm).

Avoiding fatigue
m Change your seated position, stand up, or stretch whenever you start to feel

ti red. Frequent short breaks are helpful in reducing fatigue.

m Allow adequate work space so that you can work comfortably. Place papers
or other items so you can view them easily while using your computer. A
document stand may make reading papers more comfortable.

m Eye muscles must work harder to focus on nearby objects. Occasionally
focus your eyes on a distant object, and bli nk often while you work. 

m Clean your screen regularly. Keeping the screen clean helps reduce
unwanted reflections.

What about electromagnetic emissions?

There has been recent public discussion of the possible health effects of
prolonged exposure to extremely low frequency (ELF) and very low
frequency (VLF) electromagnetic fields. Such fields are associated with
electromagnetic sources such as television sets, electrical wiring, and some
household appliances—as well as computer monitors.

Apple has reviewed scientif ic reports and sought the counsel of government
regulatory agencies and respected health organizations. Based on the
prevailing evidence and opinions, Apple believes that the electric and
magnetic fields produced by computer monitors do not pose a health risk. 
In response to those customers who wish to reduce their exposure to
electromagnetic fields, Apple has lowered the emission levels of its products. 
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Important care and safety instructions

For your own safety and that of your equipment, read and follow all the
instructions in this section. Keep these instructions available for reference by
you and others.

Warning
m Electrical equipment may be hazardous if misused. Operation of this

product, or similar products, must always be supervised by an adult. Do not
allow children access to the interior of any electrical product and do not
permit them to handle any cables.

m Do not use the computer in or near water.

m Do not use cables that are frayed or otherwise damaged. Hold a cable by its
connector (the plug, not the cord) when connecting or disconnecting it.

m Always handle batteries carefully.

m Do not drop, puncture, mutilate, or burn the computer or battery.

m Transport batteries either inside the computer or with the protective cap
covering the battery contacts.

Caution
m If you have a problem with your computer and nothing in the computer

manual solves the problem, take the computer to your Apple-authorized
dealer or service provider. Attempting to repair the computer yourself may
void the limited warranty.

m Do not move the computer when you can hear its hard disk spinning.
When you put the computer to sleep, wait until the screen is blank before
moving the computer.

m Never force a connector into a port. Make sure that the connector matches
the port and that it’s right side up. If the connector and port do not join
easily, they do not match.

m Do not use the computer in wet or dusty environments.
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m Keep dirt and liquids away from the ports on the back panel, the keyboard,
and the trackpad. If you spill any food or liquid onto the computer, shut it
down immediately and unplug it before cleaning up the spill. Depending
on what you spilled and how much got into the computer, you may have to
bring the computer to an Apple-authorized service provider for cleaning.

m Do not touch the screen with any sharp or pointed objects.

m Use only the battery supplied with your computer, or an identical model.
Batteries designed for other portable computers may look similar, but they
may not work with your computer and may damage it.

m Use only the power adapter supplied with your computer, or an identical
model. Adapters designed for other electronic devices may not work with
your equipment and may damage it.

Important
m Use the computer only in environments where the temperature range is

between 50° F/10° C and 95° F/35° C.

m Do not expose the computer to very low (less than –13° F/–25° C) or very
high (more than 140° F/60° C) temperatures.

m If the computer has been in a cold place for several hours, let it warm up to
room temperature before you use it.

m Clean the computer’s outside surfaces with a damp (not wet) cloth. Clean
the screen with soft, lint-free paper or cloth and a mild glass cleaner. Do
not spray the glass cleaner directly onto the screen.

Caring for batteries

Always handle batteries carefully.

m Always put the battery cap on the battery when the battery is out of the
Macintosh PowerBook. The battery contacts should not be exposed when
the battery is out of the computer.

m Never get batteries wet.

m Do not short-circuit the battery terminals (that is, do not touch both
terminals with a metal object). Doing so may cause an explosion or a fi re.
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m Do not drop, puncture, disassemble, mutilate, or incinerate the battery.

m Recharge batteries only as described in this manual and only in 
ventilated areas.

m Do not leave batteries in hot locations (such as the trunk of a car).

m Do not leave a battery in your computer for longer than a week without
plugging in the power adapter.

m Do not leave a battery in storage for longer than six months without 
recharging it.

m Take dead batteries to an Apple-authorized service provider for recycli ng or
proper disposal. The batteries contain hazardous chemicals and should not
be thrown out with household or office trash.

Handling f loppy disks

125° F (52° C)

50° F (10° C)

Keep disks dry.

Do not use a
pencil or an 
eraser on a disk
or disk label.

Store disks at
temperatures
between 50° F
and 125° F.

Do not touch the
exposed part of the
disk behind the 
metal shutter.

Keep disks away 
from magnets.

Avoid exposing
disks to extremely
hot temperatures.
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Traveling with the Macintosh PowerBook

IMPORTANT  Always take the CD that came with your computer with you when
you travel. If you experience system software problems while traveli ng, you
may need these disks to correct any problem.

Airplanes and airports

Some airli nes have reported that use of portable electronic devices may have
interfered with the aircraft’s flight navigation or communications systems.
Many airli nes restrict or manage the use of electronic equipment during
fli ghts. Please respect the regulations of the airli nes.

A properly tuned X-ray machine should cause no damage to your Macintosh
PowerBook. But the motors that drive the belts on some security machines
have magnets that can damage your information. To avoid problems, place 
the Macintosh PowerBook close to the entrance of the machine and remove it
as soon as possible. At most airports you can also have the computer hand-
inspected by security personnel.

Metal detectors should not damage the Macintosh PowerBook. 

Security officials may require you to turn the Macintosh PowerBook on.
Make sure you have a charged battery on hand.

Handling your Macintosh PowerBook

The safety instructions earlier in this appendix also apply when you are
traveli ng. In addition, note these precautions:

m Do not transport your Macintosh PowerBook while it is turned on. Put
your computer to sleep or shut it down before you move it.

m Transport batteries either inside the computer or with the protective cap
covering the battery contacts. Do not transport unprotected batteries.

m Do not check your computer as baggage. Carry it with you.

m Take the necessary plug adapters if you’re traveli ng overseas. (You may
need to use them with the power cord.) You do not need a voltage
transformer. The power adapter can handle 90 volts to 260 volts AC 
(48 Hz to 62 Hz).
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Check the diagrams below to determine which plug adapters you’ll n eed, or
ask your travel agent.

Outlet type Locations

United States, Canada, parts of Latin America, Japan, Korea, the Philippines,
Taiwan

Russia and the Commonwealth of Independent States (CIS), most of Europe,
parts of Latin America, the Middle East, parts of Africa, Hong Kong, India, most of
South Asia

Mexico, United Kingdom, Ireland, Malaysia, Singapore, parts of Africa 

China, Australia, New Zealand

International repair and service

Apple’s global limited warranty covers your Apple products for one year,
regardless of where the products are purchased. The Apple-authorized service
providers in more than 80 countries can handle most repairs (unless the
repair involves a component specif ic to another area of the world). Bring a
copy of your proof of purchase with you.

Because of variations in environment and power supplies, Apple is not
responsible for damage to Apple products used outside the United States. 

Storing the Macintosh PowerBook

1 Save your work on a hard disk or floppy disks.

2 Make sure the battery is fully charged.

3 Press the Power key and click Shut Down, or choose Shut Down from the Special menu.

4 Close the display.

5 Store the computer in a cool, dry place.

Storage temperatures should remain between –25° C and 60° C (between
–13° F and 140° F). Avoid leaving the computer where temperatures may be
extreme or unpredictable—in the trunk of a car, for example.
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Service and support

If your computer is malfunctioning but does not appear to be physically
damaged, shut it down (and leave the power adapter plugged in, if possible)
until you can get help.

If you know or suspect that your computer is physically damaged, disconnect
the power adapter, remove the battery, and do not use the computer until it
can be repaired.

See the service and support information that came with your computer for
information about customer assistance.
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The keyboard on your Macintosh PowerBook computer works in much the
same way as the keyboards on other computers and on electric typewriters.
However, there are a few special keys you should know about. Many of these
keys allow you to give commands to the computer without using the trackpad.
For example, in many application programs, you can press the x (Command)
key at the same time as the Q key to quit a program. 

The illustration on the following page explains the function of all the special
keys on the keyboard of your Macintosh PowerBook computer.
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Special keys on the Macintosh PowerBook keyboard

Arrow keys Move the insertion point as an alternative to using the pointing device. 
In some programs, the arrow keys have other functions.

Caps Lock key A locking Shift key for letters only (numbers and symbols aren’t affected).
A small green light shows on the Caps Lock key when caps lock is on.

x (Command) key Works in combination with other keys as an alternative to choosing a 
menu command.

Control key In combination with other keys, provides shortcuts or modifies actions.

Delete key Deletes selected material, or the character to the left of the insertion point.

Enter key In a dialog box, pressing Enter is the same as clicking the outlined button.
In some programs, confirms information you have provided.

Escape key The function of this key depends on the program you’re using.

Function keys Some programs allow you to use function keys to give commands. You
can assign commands or action sequences to function keys with
utility programs.

Option key In combination with other keys, produces special characters or 
modifies actions.

Power key Turns the computer on and off. 

Return key Moves the insertion point to the beginning of the next line. In a dialog box,
pressing Return is the same as clicking the outlined button.

Shift key Produces capital letters (or the upper character on the key).

Tab key Moves the insertion point to the next stopping place (such as a tab stop or
data field).
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Typing special characters and symbols

You can type a variety of international and other special symbols and
characters (including characters with diacritical marks, such as accents) 
by pressing combinations of keys.

The Key Caps program, which is installed with your system software, 
shows you the characters produced when you type certain keys and key
combinations in the fonts available on your computer. Choose Key Caps 
from the Apple (K) menu, then choose the font from the Key Caps menu.

To have Key Caps show more options for special characters, press each of
these keys or key combinations: Option, Shift, Shift-Option, Shift-x, and
Option-x.
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If you press the Option key, Key Caps outli nes lightly the keys that you can
use in combination with letter keys to type letters with accents or other
diacritical marks.

If you see rectangles:  If you see rectangles instead of diacritical marks on
some of the pictures of keys in Key Caps, try pressing Option-x to see the
diacritical marks. However, you only need to use the Option key (not Option-
x) in combination with the other keys to type letters with diacritical marks.

If you press the Option key at the same time as a key for a specif ic diacritical
mark and then release both keys, Key Caps outli nes in bold the keys for
letters that can be typed with that mark. (You’ll see that most key
combinations for diacritical marks can be used with the Space bar as well 
as letter keys—producing the mark without a letter.)

The most common diacritical marks and how to create them are 
summarized next.

Diacritical mark Key combination

Grave accent ( ` ) Option-`, then type the character

Acute accent ( ´ ) Option-e, then type the character

Circumflex (^) Option-i, then type the character

Tilde (~) Option-n, then type the character

Umlaut ( ¨ ) Option-u, then type the character 

The letter “c” with a cedilla (ç) Option-c

m To type a letter or a space with a specific diacritical mark, press the Option key and
the key for the mark simultaneously. Then type the letter that needs the mark.

If you are having trouble getting a mark and letter to appear together, try
again. Be sure to press the Option key before (or at the same time as) the
key for the mark; then, after you release both keys, type the letter to be marked.
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Special key co mbinations

If dif ficulties with your trackpad or computer don’t allow you to use standard
methods of quitting a program or restarting your computer, you can try using
these special key combinations. 

To do this... …press this key combination

Force a program to quit x-Option-Esc

Force the computer to restart x–Control–Power key

Here are other key combinations you may find useful.

To do this... …press this key combination

Start a “debugging” application used x–Power key
by software programmers*

Rebuild desktop Shift key (while starting up); release, then hold
Option-x

*If you do not have a debugging program installed, your screen displays a right angle-bracket prompt (>). To return to
the desktop, press G, then press Return.
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You can purchase a RAM card to augment your PowerBook’s operation. 

Note:  You should attempt to install a RAM card only if you are comfortable
working with electronic equipment. You should read all of the following
instructions before you begin. If the procedure sounds like something you
don’t want to do yourself, any Apple-authorized service provider can install
the card for you (for a service charge).

WARNING  If you attempt to install a RAM card yourself, any damage
you may cause to your equipment will not be covered by the limited
warranty on your computer. See an Apple-authorized dealer or 
service provider for additional information about this or any other
warranty question.
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Getting ready

You will need the RAM expansion card and a screwdriver with a Torx T-8
head. (Your card may come with a Torx T-8 screwdriver. If you need to
purchase a Torx T-8 screwdriver, you can probably find one at a hardware 
or electronics supply store.) 

IMPORTANT  No other type of screwdriver can be used to install the RAM card
in your Macintosh PowerBook.

Make sure you are installing a RAM card made for your Macintosh PowerBook
computer. You can’t install a card made for another PowerBook model, such
as the 5300 series, in your computer. The RAM card must use low-profile
memory chips.

Some RAM cards made for PowerBook 3400 series computers may be
compatible with your PowerBook, but not all cards are compatible. Check
with the card’s vendor to be certain that the card is compatible with your
PowerBook computer. The RAM card available from Apple for PowerBook
3400 series computers is compatible with your PowerBook.

Connector Low-profile memory chips
(The number and position of the chips on your
RAM card may differ from those shown.)
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123Insta l l ing a Macintosh PowerBook RAM Expansion Card

Installing the card

To install the RAM expansion card, follow these steps:

1 Disconnect all cables from the computer, including the power adapter. Make sure the
computer is turned off.

2 Close and latch the display.

3 Remove the battery from the computer.

If you’re unfamiliar with this procedure, follow the instructions in “Removing
or Replacing the Battery” i n Chapter 4.



4 Turn the computer over and unscrew the three screws on the bottom of the computer. 

These screws can only be loosened with a Torx T-8 screwdriver.

Turn the computer over and
loosen these three screws.
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5 Lift up the computer and carefully turn it over to remove the three loosened screws. 

Set the screws aside.
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6 Set the computer down and open the display to its maximum angle.

Side view
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7 Gently lift the side panels of the computer a short distance. 

Be careful not to lift too far. A slight lift should raise the keyboard enough for
you to grasp it.

Gently lift the side panels of the computer up a short distance
(approximately 1/4"). You don’t want to remove the side
panels; you only want to raise the keyboard slightly so
that you can grasp the keyboard with your fingers
and be able to lift it out of the computer.

WARNING  Do not lift the side panels
up more than approximately 1/4".

Side view
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8 Carefully pull the keyboard forward to loosen the four tabs at the top. Be very careful to
avoid pulling the keyboard out too far. The cable attaching the keyboard to the computer
is very short.

This action should release the top edge of the keyboard from its enclosure,
allowing you to grasp and free the entire keyboard. 

WARNING  Don’t pull the keyboard away from
the display more than 3/8". If you pull the keyboard
away from the display more than 3/8", you may
pull this cable out of its socket.

Gently slide the keyboard away from the display a short distance to disengage these tabs.
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9 Place a clean, dry cloth over the display to protect it. 

Place a soft, dry, clean cloth over the
display to protect it from scratches.
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10 Lift the keyboard out of its enclosure and place it on the clean, dry cloth covering 
the display. 

Again, be very careful not to lift the keyboard too far out of its enclosure so
that you don’t pull the keyboard cable out of its socket.

Don’t turn the keyboard over; just slide it up on the cloth.

Gently move the keyboard up and place it on the cloth
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11 Gently touch the metal surface on the right side of the inside of the computer to
discharge any static electricity built up on your body.

This prevents you from damaging your Macintosh PowerBook or RAM card.

Don’t walk around while installing the card. If you do, make sure you do this
step again to discharge any static electricity.

Avoid touching the heat sink inside the computer
(shown in color here). If the computer has been
on for a while, or the power adapter has been
plugged in and charging the battery, the heat
sink may have become hot. You may wish
to allow it to cool for a few minutes
before proceeding with the
RAM card installation
procedure.

Touch the inside of the computer in this area to dissipate
any static electricity that may have built up on your body.
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12 If you are replacing a RAM card, lift the corner of the RAM card you are replacing to
remove it.

Be careful not to touch other parts of the computer’s interior when lifting the
card. Some parts may be hot if the battery has been charging or the computer
has recently been used.

If you’re replacing a RAM card, you’ll need to remove
the old one. Lift up on the RAM card in this corner
to remove it.

RAM card



13 Remove the new RAM card from its protective package.

Hold the card by its edges. Don’t touch the chips or metal parts of the card. 

IMPORTANT  Use a RAM card with TSOP low-profile RAM chips only.
Installing a card with high-profile chips may damage your computer.

Save the protective package that the RAM card came in, in case you want to
remove the card later.

14 Lower the card into the computer and align its connector with the socket on the main
circuit board.

Make sure the ribbon cables for the keyboard go on top of the installed card.

Install the RAM card into this socket. These ribbon cables go on top of the installed RAM card.

Connector

RAM card
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15 Lay the card flat, then gently press the card into the socket.

You need to exert some pressure to insert the card’s connector into the socket.
It’s all right to wiggle the card to move it or to insert one side and then the
other, but be very careful not to bend or bow the card. 

Make sure the keyboard cables are still properly connected.

Check to see that the RAM card is properly seated
in its socket. Press down firmly on these two
areas and be sure that the RAM card
has clicked into place.

Check to see if either of these keyboard cables has
been pulled out of its socket on the logic board.
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If the keyboard cables are loose, follow these steps to replace the cables:

Be careful not to remove the foam on the keyboard cable. It protects the cable
and keeps it from touching the RAM card.

1  Lift the bail on the connector with a straightened paper clip or similar object.

2  Insert the ribbon cable into the connector.

3  Push down on the bail with a straightened paper clip or similar object
    to secure the ribbon cable.

Bail

1 2 3
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16 Move the keyboard back toward its original position, and then slide the tabs at the top
into the computer’s enclosure.

Hold the keyboard no more than an inch above the enclosure to avoid
straining the cables.

17 Lower the keyboard into place.

If part of the keyboard doesn’t lie flat within the enclosure, gently press that
area down with your hand.

18 Remove the cloth from the display.

Gently slide the keyboard back into the computer. These tabs go inside the computer.
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19 Slightly close the display so it is at a 90-degree angle to the computer.

20 While holding the keyboard in place, rotate the Macintosh PowerBook so that the bottom
of the computer is exposed, with the display flat against the table surface. 

While holding the keyboard in place so that it doesn’t fall out, rotate
the computer so that the display is flat against the table surface.

Side view

90°
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21 While continuing to hold the keyboard in place, replace the three screws on the bottom
of the Macintosh PowerBook.

Not too tight:  Take care not to overtighten the screws. Tighten them only until
they are snug (when you feel resistance to your turning motion). It’s better to
leave them a bit loose than to make the screws too tight.

22 Turn over the computer and prepare to use it.

Replace the battery and reconnect the power adapter and any cables you
removed before installing the RAM expansion card.

1 Gently but firmly squeeze the
keyboard and the other parts of
the computer together.

2 While squeezing the parts together,
reinstall the three screws into the bottom
of the computer.

138 Appendix  C



Making sure the card is properly installed

Once you have completed the process for installing a RAM expansion card,
you can check to make sure the additional RAM is now available on your
computer. Follow these steps:

1 Press the Power key to turn your computer on.

2 Choose About This Computer from the Apple ( K) menu. 

3 Look at the number of the total memory in your computer.

Your total memory should be the built-i n memory plus the amount of
memory in the RAM expansion card that you just installed.

If the total memory number does not include the amount of RAM you
installed, review the steps in this appendix to make sure you installed the
card correctly. If you need more help, see an Apple-authorized dealer.

If you hear a different sound (breaking glass) or see a message that a memory
error was detected when the computer started up, there may be a problem
with the RAM expansion card. You should remove the card.

If you installed the RAM expansion card in your computer yourself, review
the steps in this appendix to make sure you installed the card correctly. If you
purchased an expansion card from a third-party manufacturer, contact the
manufacturer for help.

You should run a full memory diagnostic program (not supplied with the
computer) to verify the operation of the RAM card. An Apple-authorized
technician can advise you about this procedure.

139Insta l l ing a Macintosh PowerBook RAM Expansion Card





Your Macintosh PowerBook computer came with a card installed in the PCI
expansion slot. The card provides an Ethernet connection or modem and
Ethernet connections.

You can easily determine which type of card your computer has. Open the
cover on the computer’s back panel. On the computer you’ll see a modular
telephone-style connection (a socket) and on the cover is a label that shows
the Ethernet icon (G) or a combined Ethernet and modem icon (G/W).

The cable or cables you need to use with the card are also supplied with 
the computer.

Label showing icon for card

Connector for
Ethernet/modem
or Ethernet card 

141

Appendix D  Making Modem and Ethernet
Connections to an Internal Expansion Card

Refer to this appendix for 

information on connecting Ethernet

and telephone cables to an

expansion card in your computer.
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Connecting an Ethernet cable to the expansion card

Follow these steps to connect an Ethernet cable to the card in your PowerBook:

1 Open the cover on the computer’s back panel and verify that your computer has a card
with a modular connector. 

You can connect a modular (twisted-pair or 10Base-T) Ethernet cable to an
Ethernet-only card or to the combination Ethernet/modem card. (A shielded
Ethernet cable is supplied with your computer.)

2 Locate a modular Ethernet cable and connect one end of the cable to the network.

Consult a network administrator or other expert if you need help making the
network connection.

3 Connect the free end of the Ethernet cable to the modular connector on the card.

4 Start up the PowerBook, if it is not already on.

5 To use your Ethernet connection, open the AppleTalk control panel and choose Ethernet
from the “Connect via” pop-up menu.

If you want to use a TCP/IP-based application, you may want to make sure
that the TCP/IP control panel is configured appropriately.

For more detailed instructions on using the network control panels, see the
Networks topic area of Mac OS Help, available in the Help menu.

Modular
connector
on card

Ethernet cable



Connecting a telephone line to the expansion card

If your card provides both modem and Ethernet connections, follow these
steps to connect a standard telephone line to the card in your PowerBook:

1 With the PowerBook shut down, open the cover on the computer’s back panel and verify
that your computer has a card with a modular connector. 

You can check the label on the inside of the cover to determine that the card
provides a modem.

2 Connect one end of a modular telephone cord that came with your computer to the wall
socket for a residential phone line.

3 Connect the other end of the telephone cord to the modular connector on the card.

Modular
connector
on card

Telephone connector

WARNING  Make certain that the phone line is the standard (analog)
residential line, not a digital line. Connecting a digital line to your
modem card could damage it. Also, you must use a single-line
telephone cord (supplied with your computer) to connect to the
telephone line. A single-line phone cord has only two wires visible in
the plastic connector (as opposed to the commonly used four-wire cord).  

2 visible wires

Single-line telephone cord
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4 Start up the PowerBook, if it is not already on.

5 To use your modem, open the communications program you want to use and set up the
program for the internal modem.

You also have fax software on your computer’s hard disk. See the electronic
manual located with the fax software for instructions.

In addition, your PowerBook has a collection of programs that give you
access to the Internet. These programs are on the computer’s hard disk. You
can find out more about these programs in the Mac OS Info Center on the
hard disk.

For more information about using a modem, see the “Connecting to the
Internet” and Telecommunications topic areas of Mac OS Help, available in
the Help menu.

IMPORTANT  When you connect to the Internet or other service with your
modem, you may see a message that reports a connection speed. The
connection speed may vary, depending on the telephone line, the quality of
the connection, and other factors that affect communications.

Using Ethernet and a modem at the same time

By using the adapter supplied with your computer if you have a combination
Ethernet/modem card, you can connect both an Ethernet cable and a
telephone line to the card. (In addition, you do not have to use the single-line
(two-wire) phone cord when you use the adapter.)

To use both Ethernet and the modem, follow these steps:

1 Open the cover on the computer’s back panel and verify that your computer has a card
with a modular connector. 

You can check the label on the inside of the cover to determine if you have
the combination card.

Ethernet/modem card label

G W/
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2 Locate the adapter that came with your computer and connect the single end of it to the
card in your computer.

3 Prepare the Ethernet cable and telephone line as you would for a single connection of
either type.

4 Plug the modular connector from the Ethernet cable and the telephone cord into the two
sockets in the Y-adapter.

5 Start up the computer (if it is not already on) and set up your software to use the modem
and Ethernet connections.

Y-adapter

W Telephone connector

G Ethernet connector





A

About This Computer
(Apple menu)  66, 139

AC adapter. Seepower adapter
accent marks, typing  117–118
access privileges to shared disks or files

79, 80, 81
acute accent (´), typing  118
adapters. See alsopower adapter

Ethernet/modem card  144–145
monitor  42, 43, 44
plug  112–113
video  73

ADB devices, connecting  47
ADB port  2, 31, 47
airline regulations for portable computers

112
analog phone lines  30, 83, 143
Apple Assistance Center  57, 59, 73
Apple-authorized service

providers/dealers
battery repair or replacement  52
disposing of spent batteries  55, 111
flickering screen  73
installing a RAM expansion 

card  121, 139
liquid spills onto the computer  110
memory upgrades  48

obtaining Apple peripheral 
devices, cables, and 
connectors  23, 42

RAM or cache memory errors  70
recovering the hard disk  88
repair service  57, 59, 87, 109, 113

Apple Desktop Bus. SeeADB
Apple menu

About This Computer  66, 139
Chooser  32, 33, 74–75, 79–81
Key Caps  72, 117–118

Apple multiscan external monitors
supported  41

Apple Remote Access  82–83
AppleTalk

connecting an Ethernet cable and  142
connecting an external modem and  33
connecting a printer and  32, 75
conserving battery power and  56
using a network or file sharing and

79–81
AppleTalk control panel  79
Application menu, Show All  67
arm discomfort or pain from using

computers  107
arrow keys  116
ATA hard disk, preventing ejection at

startup  28–29
automatic sleep  12, 51. See alsosleep
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Index

If you can’t find what you’re looking for 

in this index, look in Mac OS Help—

available in the Help menu 

on your computer.

Notes
To go to a page, click its page number.



B

backlighting, conserving battery 
power and  56

backup cell  50
battery

conserving power  10, 12, 50–51, 56
disposal of  55, 111
expected work time from  49, 56
handling  110–111
illustration  2, 5
inserting  55
locking  23
monitoring the charge level  50–52
recharging  5–6, 49, 51, 53, 63
removing/replacing  54–55
safety instructions for  5, 51, 109,

110–111, 112
SCSI disk mode and  35, 38
transporting  109
troubleshooting  58
unwrapping  4–5

battery cap  54, 55, 109, 110
battery icons, interpreting  51
battery level indicator button  52
battery level indicator lights  50, 52
battery release button  5, 54
brightness control

adjusting  8, 58, 60, 73
illustration  2, 8

C

cables
for Ethernet connections  

141, 142, 144
for external monitors  42, 43, 44
HDI-30 SCSI Disk Adapter Cable

34–35, 36–37, 38, 77–78
HDI-30 SCSI System Cable  34–35,

37, 77–78
keyboard  128, 130, 133–135
safety instructions for  36, 109
SCSI Peripheral Interface Cable

34–35

Caps Lock key  116
carpal tunnel syndrome  104
CD-ROM drive

opening  19, 21, 90
switching with another module  15–18
using CDs in  19–21
vibrations and noise in  20

CDs
care of  20
conserving battery power and  56
ejecting  21–22
inserting  19–20, 90
starting up the computer with  59, 87,

90, 97
cedilla (ç), typing  118
chair, adjusting for optimal support and

comfort  105
charge level of battery, monitoring

50–52
charging the battery  5–6, 49, 51, 53, 63
Chooser (Apple menu)

connecting an external modem  33
connecting a printer  32, 74–75
network troubleshooting  79–81

circumflex (^), typing  118
cleaning the computer  110
clean installation of system software  

92, 99–101
colors, decreasing number to display  73
color support on external 

monitors  40–41
Command (x)-Control-Power keys, to

restart the computer  10, 13, 58,
59, 62, 63, 119

Command (x)-E keys, to eject a CD  21
Command (x) key  116
Command (x)-Option-Esc keys, to force

a program to quit  62, 63, 119
Command (x)-Option keys, to rebuild

the desktop  67, 68, 119
Command (x)-Option-P-R keys, to reset

PRAM  59, 86
Command (x)-Power 

keys, to start a debugging
application  119
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compact discs. SeeCDs
compatibility issues, programs and

system software extensions  
65, 85–86

connecting
ADB devices  47
to another computer  35–38
an Ethernet cable to an expansion 

card  141, 142
an external modem  33
an external monitor  39, 42–44
a mouse or keyboard  47
to a network  79–81
a printer  32
SCSI devices  34–38
sound input and output devices  45–47
a telephone line to an expansion card

30, 82–83, 143–145
connection speed of modem  144
connectors

Ethernet/modem or Ethernet card  
2, 31, 141–145

RAM expansion card  122, 133–134
safety instructions for  109
telephone  143–145

conserving battery power  10, 12, 
50–51, 56

Control key  116
control panels

AppleTalk  79
Easy Access  69
Extensions Manager  62, 86
File Sharing  80, 81
Infrared  48
Memory  61–62, 66, 69
Monitors & Sound  46, 47, 73
Password Security  23, 37, 76, 77, 90
PowerBook  67, 73, 74
PowerBook Setup  36
Remote Access Setup  82–83
resetting PRAM and  59
Sound  69
Startup Disk  28–29, 71, 97
TCP/IP  79, 142

Control Panels folder  86

Control Strip
adjusting display of colors  73
adjusting sound volume  47
changing external monitor 

resolution  43, 73
monitoring the battery charge  50, 53

cumulative trauma disorders (CTDs)  104
customer assistance  114. 

See alsoApple-authorized
service providers/dealers

custom installation of system 
software  93, 95–97

custom settings and special software,
restoring  89

D

data transfer, with infrared
communications  48

Delete key  116
Desktop PrintMonitor  75
diacritical marks, typing  117–118
diagnostic techniques. See alsoerror

messages; troubleshooting
checking system software 

extensions  85–86
reinstalling system software  88–101
testing your hard disk  87–88

digital phone lines  30, 83, 143
dimming of the screen. 

Seescreen-dimming feature
discharging static electricity  131
disk cache  62, 66, 69, 86
Disk First Aid program  91
disk-security software  90
display

electromagnetic emissions from  108
minimizing glare and 

reflections  107, 108
opening  3–4
positioning  3, 107
troubleshooting  72–73

disposal of spent batteries  55, 111
docking mode  40
Drive Setup program  87–88, 92, 98
dual speakers  2



E

Easy Access control panel  69
Eject CD command (File menu)  21
ejecting

CDs  21–22
floppy disks  70
PC Cards (PCMCIA cards)  26–28
shared disks  80

Eject PC Card command, 
Special menu  26

electrical outlet types for most 
countries  113

electromagnetic emissions from 
monitors  108

elevation feet  2, 4, 107
elevation foot release button  2, 4, 107
Empty Trash command 

(Special menu)  98
Enter key  116
equipment, arranging to prevent

discomfort  105–108
error messages. See alsodiagnostic

techniques; troubleshooting
about font files  68
about system errors  63
about system software  60, 61
“Apple Remote Access is not installed

correctly”  83
“a problem was detected with RAM or

cache memory”  70
“disk can’t be ejected because it’s

being shared”  80
“file sharing can’t be turned on”  80
“item can’t be shared”  80
“not enough disk space”  98
“not enough memory”  61–62, 66
number codes in  61, 64
“program can’t be found”  67
“program has quit”  65
“sad Macintosh” icon  59
“System file cannot be modified”  99
when trying to print  75

Escape key  116
Ethernet cable, connecting to an

expansion card  141, 142, 144
Ethernet/modem or Ethernet card

141–145
Ethernet/modem or Ethernet connector

2, 31, 141–145
expansion bay drive in-use light  2
expansion bay module

inserting  18
locking  23
purchased from an independent

supplier  15
removing  15, 16–17
unlocking  16
using narrow modules  18

expansion card
connecting an Ethernet cable to  

141, 142
connecting a telephone line to  30,

82–83, 143–145
label for  2, 31, 141, 144

extensions. Seesystem software
extensions

Extensions folder  75, 82, 86
Extensions Manager control panel  62, 86
external disk drive, using the PowerBook

as  35–38, 76–78
external modems  33, 78
external monitor

changing resolution of  43, 73
connecting  42–44
disconnecting  44
electromagnetic emissions from  108
minimizing glare and reflections  108
positioning  42, 108
PowerBook support for  39–41
selection considerations  39–40
troubleshooting  43–44, 72, 73–74, 78
video adapter  73

external monitor port  2, 31, 39, 43, 44
eye fatigue from computer use  

103, 105, 108
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F

fatigue from computer use  103, 105, 108
File menu

Eject CD  21
Get Info  64, 66, 68, 75, 99
Open  67
Put Away  15, 16, 17, 21, 26
Sharing  69

files
infrared transfer of  48
locked  68, 99
troubleshooting  68–69
unlocking  68, 99

file sharing
troubleshooting  79–81, 86
turning off  69

File Sharing control panel  80, 81
File Sharing folder  80
Finder  10, 12
Find File command  63, 64
flashing question mark on screen  

9, 61, 77
floppy disk drive

illustration  2
switching with another module  15–18
troubleshooting  70–71

floppy disks
ejecting  70
handling  111
troubleshooting  70–71
unlocking  65, 69, 71

folders
Control Panels  86
Extensions  75, 82, 86
File Sharing  80
Fonts  68
Modem Scripts  82
Preferences  80
Previous System Folder  99, 101
shared  69
System Folder  64, 86, 99–101
Utilities  87, 98

font files, troubleshooting  68
Fonts folder  68
Force Quit  62, 63
Function keys  116
furniture, arranging to prevent discomfort

105–106

G

Get Info command (File menu)  64, 66,
68, 75, 99

graphics tablet, connecting  47
grave accent (`), typing  118
gripping surface on the expansion bay

module  17, 18
grounding the computer  6

H

hand discomfort or pain from using
computers  107

hard disk
avoiding damage to  11
making space available  98
protecting with a password  23
reinitializing  88, 98
repairing  98
testing  87–88
troubleshooting  71, 87, 98
using the PowerBook as  35–38,

76–78
HDI-30 SCSI Disk Adapter Cable

34–35, 36–37, 38, 77–78
HDI-30 SCSI System Cable  34–35, 37,

77–78
health-related information about

computer use  103–108
heat sink inside the computer  131
Help menu  13, 14, 57
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I, J

icons
battery  51
blinking in the menu bar  69
dragging to the Trash  15, 16, 17, 

21, 26
look different from usual  68
“sad Macintosh”  59
SCSI  37, 76

ID numbers for SCSI devices  34, 36, 
37, 78

Infrared control panel  48
Infrared Data Association Standard

specifications  48
infrared file transfer  48
infrared window  2, 31
initializing the hard disk  88, 98
inserting

a battery  55
CDs  19–20, 90
an expansion bay module  18
PC Cards (PCMCIA Cards)  25–26

installing
RAM expansion card  121–139
system software  88–101

interference
on an external monitor  74

international symbols and characters,
typing  117–118

Internet  144
IR. Seeinfrared
IRTalk transfer protocol  48

K

keyboard
adjusting  107
cables  128, 130, 134–135
connecting  47
positioning your hands on  106–107
raising and loosening  127–128
replacing  135–136
special keys on  116
troubleshooting  72, 78

Key Caps (Apple menu)  72, 117–118

L

label for expansion card  2, 31, 141, 144
liquid spills on the computer  110
lithium ion (LiIon) battery. 

See alsobattery
disposal of  55, 111
overview  49
using battery level indicator 

lights  50, 52
location for computer, choosing  1, 105
locked disks  65, 69, 71
locked files  68, 99
locking the expansion bay module and

battery  23
low-power messages  38, 50–51
low-profile memory chips  122, 133

M

Macintosh Easy Open, rebuilding the
desktop and  67, 68

Mac OS 8, installing  89–101
Mac OS Help  13, 57
Mac OS Info Center  14, 144
Mac OS Install program  91–101
Mac OS Setup Assistant  13, 14
memory. See alsoRAM

adding  48, 121–139
checking amount of  139
freeing/reassigning  66
troubleshooting  60, 61–62, 65, 66, 69
virtual  48, 61, 66, 86

Memory control panel  61–62, 66, 69
memory diagnostic program  139
microphone

built-in  2, 45, 46
PlainTalk  45

mirroring  39
modem/printer port. Seeprinter/external

modem port
modems

external  33
PC Card  29–30, 143–145
troubleshooting  82–83

Modem Scripts folder  82
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module release latch  16, 17, 18
monitor. Seeexternal monitor
monitor adapter  42, 43, 44
monitor cable  42, 43, 44
Monitors & Sound control panel  

46, 47, 73
monochrome external monitors supported

40, 41
mouse

connecting  47
positioning  107
troubleshooting  78

moving the computer  109, 112–113
musculoskeletal discomfort from

computer use  103, 104, 108

N

network problems, troubleshooting
79–81

nickel-metal-hydride (NiMH) battery.
See alsobattery

disposal of  55, 111
overview  49

NTSC Display external monitors
supported  41

O

office furniture, arranging to prevent
discomfort  105–106

online information/help  13–14, 57
Open command (File menu)  67
opening

the CD-ROM drive  19, 21, 90
the display  3–4
shared disks or files  79–81

Option key  116, 117–118, 119

P

PAL Display external monitors 
supported  41

paper wrapper covering the battery  4–5
parameter RAM. SeePRAM
part numbers

for monitor adapter  42
for power adapter  5, 49
for SCSI cables  34

password protection
SCSI disk mode and  37, 76, 77
turning off  37, 76, 77, 90
turning on  23

Password Security control panel  23, 90
SCSI disk mode and  37, 76, 77

PC Card eject buttons  2
PC Card modems  29–30, 143–145
PC Cards (PCMCIA cards)

compatibility issues  24
conserving battery power and  56
ejecting  26–28
inserting  25–26
preventing ejection at startup  28–29
slots for  2, 24, 25
storage case  15, 18
troubleshooting  27–28
types of  24

Personal Web Sharing  93
plug adapters for overseas travel

112–113
ports

ADB  2, 31, 47
external monitor  2, 31, 39, 43, 44
power adapter  2, 6, 31, 53
printer/external modem  2, 31, 32
safety instructions for  109, 110
SCSI (HDI-30)  2, 31, 36, 37
sound input  2, 31, 45, 46
sound output  2, 31, 46

positioning
the display  3, 107
an external monitor  42, 108
the keyboard and trackpad  106–107
a mouse  107

153Index



power, conserving  10, 12, 50–51, 56
power adapter

charging the backup cell  50
overseas travel and  112
part number  5, 49
plugging in  5–6
recharging the battery with  49, 53, 63
SCSI disk mode and  38
troubleshooting  8, 58

power adapter port  2, 6, 31, 53
PowerBook CD, starting up the computer

with  59, 87, 90, 97
PowerBook control panel  67, 73, 74
PowerBook Setup control panel,

assigning a SCSI ID number  36
power conservation settings, 

changing  71
power cord  6

for an external monitor  42
Power key

illustration  2, 7, 116
putting the computer to sleep  11
restarting the computer  12, 13, 119
turning on the computer  7, 8, 116
turning off the computer  9, 10, 

113, 116
waking the computer  9, 10

power sources  49
PRAM, resetting  59–60, 86
Preferences folder  80
Previous System Folder  99, 101
printer

connecting  32
troubleshooting  74–75, 78

printer/external modem port  2, 31, 32
programs

compatibility issues  65
quitting before removing expansion

bay modules  15, 16, 17
troubleshooting  63–67

Put Away command (File menu)  15, 16,
17, 21, 26

putting the computer to sleep  10–12, 
17, 56

Q

question mark flashes on screen  9, 61, 77
QuickDraw 3D  93
quitting programs, removing expansion

bay modules and  15, 16, 17
quitting SCSI disk mode  38

R

RAM. See alsomemory; PRAM
retaining contents of following 

low-battery messages  51
testing  59

RAM disk
memory problems and  62, 66, 69
resetting PRAM and  59
restarting the computer and  12

RAM expansion card
connectors  122, 133–134
installing  121–139
troubleshooting  60
verifying operation of  139

Read Me file  89
rebuilding the desktop  62, 67, 68
recharging

the backup cell  50
the battery  5–6, 49, 51, 53, 63

recording sound  45–46
refresh rate on external monitors  40–41
reinitializing the hard disk  88, 98
reinstalling system software  88–101
release button

on battery  5
for elevation feet  2

release latch for expansion bay module
16, 17, 18

Remote Access Setup control panel
82–83
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removing
the battery  54–55
CDs  21–22
an expansion bay module  15, 16–17
paper wrapper on the battery  4–5
PC Cards (PCMCIA cards)  26–28
a RAM expansion card  123–132
system software components  

93, 95–97
repetitive stress injuries (RSIs)  104
replacing

the battery  54–55
a RAM expansion card  123–139

reset button
illustration  2, 31
when the battery is drained  8
when the computer won’t restart  

13, 58–59, 62, 63
when the computer won’t shut down

10, 37
resetting PRAM  59–60, 86
resolution on external monitors  

39–41, 74
Restart command (Special menu)  

12, 13, 90
restarting the computer  12–13, 58–59,

62, 63, 119. See alsostarting up
the computer; turning on the
computer

restoring custom settings and special
software  89

Return key  116
RGB external monitors supported  40, 41
ribbon cables for keyboard  128, 130,

133–135

S

“sad Macintosh” icon, 
troubleshooting  59

safety instructions
batteries  5, 51, 109, 110–111, 112
cables  36, 109
cleaning the computer  110

connecting SCSI devices  34
connecting a telephone line to a

modem card  30, 83, 143
connectors  109
ejecting PC Cards 

(PCMCIA cards)  26
floppy disks  111
grounding the computer  6
keyboard and trackpad  110
liquid spills onto the computer  110
moving the computer  11, 109, 112
ports  109, 110
power adapter  53
removing expansion bay modules  

15, 16, 17
temperature ranges for the computer

110, 113
saving settings  7
saving your work

determining battery charge level 
and  52

low-power messages and  50
removing/replacing the battery and

54, 55
restarting the computer and  62, 63

screen. Seedisplay; external monitor
screen-dimming feature

adjusting onset of  67, 74
external monitors and  44, 73–74
low-power messages and  51
restoring brightness  67, 72
turning off  73, 74

screwdriver, type needed to install a
RAM expansion card  122, 124

SCSI cables  34–35, 36–37, 38, 77–78
SCSI chains  34, 36–37, 38
SCSI devices

connecting  34–38
troubleshooting  76, 78

SCSI disk mode  35–38, 76–78
SCSI (HDI-30) port  2, 31, 36, 37
SCSI icon  37, 76
SCSI ID numbers, setting  34, 36, 37, 78
SCSI Peripheral Interface Cable  34–35

155Index



SCSI terminators  34, 35, 77, 78
security cable and lock  23
security slot  2, 23
service and support  114. See also

Apple-authorized service
providers/dealers

settings, saving  7
setting up the computer  1–6
Setup Assistant. SeeMac OS 

Setup Assistant
shared disks  79–81, 83
shared folders  69
Sharing command (File menu)  69
Shift key  116

Key Caps program and  117
Show All command 

(Application menu)  67
Shut Down command (Special menu)

10, 13, 113
shutting down the computer  9–10, 113
side panels of computer, lifting  127
SimpleSound program  46
simulscan  39, 44
single-line telephone cord  143, 145
sleep. See alsowaking the computer

automatic  12, 51
following low-power messages  51
preventing  90
putting the computer to sleep  10–12,

17, 56
Sleep button  11
Sleep command (Special menu)  11
sleep indicator  2, 11, 59
Small Computer System Interface. 

SeeSCSI
sound

adjusting volume  47
recording  45–46
unusual sound coming from the

computer  69
Sound control panel  69
sound input/output devices, connecting

45–47
sound input port  2, 31, 45, 46
sound output port  2, 31, 46
speakers  2

Special menu
Eject PC Card  26
Empty Trash  98
Restart  12, 13, 90
Shut Down  10, 13, 113
Sleep  11

speed variations of CDs  20
SRAM card, preventing ejection at

startup  28–29
standard installation of system software

93, 94
starting up the computer. See also

restarting the computer; turning
on the computer

with extensions off  60, 61, 85–86
switching expansion bay modules 

and  15
with the system software CD  59, 87,

90, 97
troubleshooting  58–62, 71

Startup Disk control panel
preventing ejection of storage PC

Cards at startup  28–29
selecting a startup disk  71, 97

static electricity, discharging  131
stereo miniplug  46
stereo speakers  2, 46
storage PC Cards, preventing ejection at

startup  28–29
storing the computer  113
SVGA external monitors, connecting  

39, 42, 43
symbols and international characters,

typing  117–118
system failures  64
System Folder

creating new  99–101
discarding extra  64
locating problem extensions in  86

system software
installing  89–101
troubleshooting  9, 60, 61, 87, 97–99

system software CD, starting up with  
59, 87, 90, 97

system software extensions
turning off  60, 61, 62, 85–86
turning on  86

156 Index



T

Tab key  116
TCP/IP control panel  79, 142
telephone cord, type to use  143, 145
telephone line, connecting to a modem

card  30, 82–83, 143–145
temperature ranges

for the computer  110, 113
for floppy disks  111

terminators, SCSI  34, 35, 77, 78
testing

the hard disk  87–88
RAM  59, 139

three-wire grounding plug  6
tilde (~), typing  118
Torx T-8 screwdriver  122, 124
trackpad

correct position for your hands
106–107

illustration  2, 106
troubleshooting  71–72

trackpad button  2
transferring information between

computers  35–38
using infrared file transfer  48

transporting the computer  109, 112–113
Trash, dragging icons to  15, 16, 17, 21,

26
tray of CD-ROM drive, opening/closing

20, 21–22
troubleshooting. See alsodiagnostic

techniques; error messages
battery problems  52, 58, 63
computer “freezes”

at restart  13, 62
at shutdown  10
at startup  61, 86
when screen dimming takes effect

73, 74
when you’re working in a program

63–64

display problems
flickering screen  73
screen dimming  67, 72, 73
screen went blank  67, 72

external monitor problems  43–44, 72,
73–74, 78

floppy disk problems  70–71
hard disk problems

in SCSI disk mode  37, 76–78
at startup  71
while installing software  98

hardware problems
ejecting CDs  22
ejecting PC Cards 

(PCMCIA cards)  27–28
keyboard  72, 78
modem  82–83
mouse  78
pointer sticks or jumps  72
power adapter  8, 58
printer  74–75, 78
SCSI equipment  76, 78
trackpad  71–72
typing produces nothing on 

screen  72
memory problems

can’t access memory  69
not enough memory  61–62, 65, 66
PRAM  59–60
RAM or cache memory errors

detected  70
RAM expansion card  60

modem problems, Apple Remote
Access  82–83

network/file sharing problems  79–81,
83, 86

shutting down the computer  10
sleep indicator light glows steady

green  59
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startup problems
computer doesn’t start up  58
computer makes unusual sounds

59–60, 69
computer shuts down right after

startup  63
desktop doesn’t appear at 

startup  60
desktop rebuilds at startup  63
flashing question mark on screen

9, 61, 77
nothing happens when you press

the Power key  8
restarting the computer  13, 58–62
“sad Macintosh” icon  59
starting up the computer  58–62, 71
turning on the computer  8–9

system software problems
computer can’t find the software  

9, 61
during installation  97–99
with extensions  86
wrong or damaged version of  60

waking the computer  63
working with programs/files

can’t open documents  67
damaged font files  68
file can’t be thrown away  68–69
icons are blinking in the menu 

bar  69
icons look different from usual  68
program quits or disappears  65–66
program won’t open  65
system errors  63
system failures  64
a window has disappeared  67

turning on the computer  7–9. See also
restarting the computer; starting
up the computer

turning off the computer  9–10. See also
Shut Down command; shutting
down the computer

Type I, II, or III PC Cards  24, 25
typing, international characters and

symbols  117–118

U

umlaut (¨), typing  118
unlocking

the expansion bay module  16
a file  68, 99
a floppy disk  65, 69, 71

unwrapping the battery  4–5
Utilities folder  87, 98

V

VGA external monitors
connecting  39, 42, 43
types supported  40

vibration in CD-ROM drive  20
virtual memory  48, 61, 66, 86
virus-detection programs  64, 90, 99
voltage transformer  112
volume control  2

W, X

waking the computer  9, 10, 12. 
See alsosleep

following low-power messages  51
troubleshooting  63

warranty on your computer  109, 
113, 121

work space, arranging to prevent
discomfort  105–106

wrist discomfort or pain from using
computers  107

Y

Y-adapter for Ethernet/modem card
144–145

Z

Zoomed Video PC Card  24, 25, 29
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Communications regulation information

FCC declaration of conformity
This device complies with part 15 of the FCC rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation. See
instructions if interference to radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception. 

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation. 

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices. 

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures: 
m Turn the television or radio antenna until the interference stops. 
m Move the computer to one side or the other of the television or radio. 
m Move the computer farther away from the television or radio. 
m Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. 

IMPORTANT  Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance. 

Responsible party:  Robert Steinfeld, Apple Computer, Inc., 1 Infinite Loop, Cupertino, CA
95014-2084, 408-974-2618.
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Industry Canada statement
This Class B device meets all requirements of the Canadian interference-causing equipment
regulations. 

Cet appareil numérique de la Class B respecte toutes les exigences du Règlement sur le matériel
brouilleur duCanada. 

VCCI Class 2 statement

Laser information
WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous radiation exposure.

WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider. 

Your Power Macintosh computer is a Class 1 laser product. The Class 1 label, located in a user-
accessible area, indicates that the computer meets minimum safety requirements. A service
warning label is located in a service-accessible area. The labels on your product may differ
slightly from the ones shown here. 

Class 1 label Service warning label
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Congratulations on the purchase of your new Macintosh PowerBook
computer. Your computer is designed to give you the highest performance
combined with real ease of use—it’s easy to set up, easy to use, and easy to
expand. This book will guide you through the setup procedure, tell you how
to expand your computer, and provide many tips on using your new system.

Your computer is powered by the new †™ microprocessor (or “chip”).
This microprocessor was designed by Apple Computer, Inc., Motorola, Inc.,
and IBM Corporation. The † microprocessor uses Reduced
Instruction Set Computing (RISC) technology to deliver very high
performance at the lowest possible cost. The † RISC microprocessor
represents the state of the art in microprocessor design.

Your new computer will run almost all your existing Mac OS software, but for
best performance and greatest speed, look for the new software programs
designed especially for computers with PowerPC microprocessors. You’ll f ind
these programs at any software store that carries Mac OS products.

ix
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